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Welcome 

o present our flagsh  product - 
iggest cha

have ever made to our software. We have switched the underlying CAD engine 
icroSurvey Software Inc. 
ll Commercial Member.  

ave dreamed about for 

ith the source code we can start to make 
small s to ays.  As a small 

e in time.   

xtremely comprehensive 
on-line help. Movies help make the printed documentation obsolete. That is why 
we reduced our manuals to a "Getting Started" book that contains the tutorials in 
a lay-flat book.  Since the help system is electronic, we can treat it as a living 
document that can be updated with each service pack or new CD. 

 on introducing more exciting products for you in the next year. Watch 
 site for news and updates on this and other MicroSurvey products. 

 

 
Yours truly, 
 
Darcy Detlor, 
President, 
MicroSurvey Software Inc. 
 

 
MicroSurvey Software Inc. is pleased t ip
MicroSurvey CAD2005.  This version contains one of the b nges we 

from the FelixCAD product to the IntelliCAD program.  M
has joined the IntelliCAD Technology Consortium as a fu
 
This provides MicroSurvey with capabilities that we h
more than 15 years. Specifically this means that MicroSurvey now has the 
source code to the CAD engine!  W

 change  improve your experience in very special w
example, we can carefully integrate the UNDO and REDO commands to 
understand surveying data.  Much more will com
 
Included with this program are 160 training movies and e

 
We plan

ebour w
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Addresses and Phone Numbers 
 

 
 

ware Inc. MicroSurvey Soft
Corporate Head Office 

d, 
Westbank, BC, V4T 2N6 

Office Hours: 8am to 5pm Pacific Time.  
) 

Sales & Technical Support 1-800-668-3312 
International Voice: +1-250-707-0000 

0
 

 info@microsurvey.com

MicroSurvey Software Inc. 
oa#110 – 2300 Carrington R

Canada 
 

(Monday to Friday, except holidays
 

Fax: +1-250-707-015  

Internet web-site http://www.microsurvey.com  
General Information:
Support E-Mail Addresses: support@microsurvey.com
 
 

Eastern Technical Support 
Office 
MicroSurvey Software Inc. 
3427 Hwy.#17 East, RR #2 
Corbeil, Ontario, P0H 1K0 
Canada 

Office Hours: 8:30am to 5:00pm Eastern Time.  
(Monday to Friday, except holidays) 
Technical Support Number: 1-877-752-2911 
International Voice: +1-705-752-2911 
Fax: +1-705-752-2133 
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Calling for Technical Support 

lp you get the most out 
formation explains how 
red promptly and 
l to check the printed 

r is already at your 
r 150 Movies that 

 explain some topics. Our Web site on the Internet can also save 

ble if requested. 
, other hardware attached 

omputer such as plotters and digitizers, version of the program, operating 
ersion. 

re that you have all the steps you completed prior to your 
sentative.  We may 

find the problem 
tely. 

 support period to all of our registered 
ctory support is available Monday to 

resentative you may use one of 

Pacific Time Technical Support (Head Office): 8:00AM-5:00PM 
Technical Support Number: 1-800-668-3312  
International Customers Please phone: +1-250-707-0000 
Technical Support fax number: 1-250-707-0150 
 
Eastern Time Technical Support Office: 8:30AM-5:00PM 
North American Technical Support Number: 1-877-752-2911 
International Technical Support Phone Number: +1-705-752-2911 
Technical Support fax number: 1-705-752-2133 
Yearly Support 
 

 
Preparing to Contact Technical Support 
 
MicroSurvey Software Technical Support is available to he
of your MicroSurvey CAD 2005 program. The following in
to prepare for your call so that your inquiry can be answe
accurately.  Take a few minutes before you place your cal
documentation and the on-line help files to see if the answe
disposal. Remember that there are several tutorials and ove
can also help
you time, please check it for assistance if you can.  If they do not help you then 
when you call please have the following information availa
Computer brand and model, CPU type and clock speed
to the c
system and v
 
Please make su
problem and can explain them to the technical support repre
ask that you forward a copy of your data to us if we cannot 
immedia
 
Phone/Fax Support 
 
Introductory Support 
MicroSurvey offers a 90-day complimentary
users, starting the date of purchase.  Introdu
Friday except holidays. To reach a technical rep
the follow
 

ing; 

Getting Started in MicroSurvey CAD 2005 3 



 

4  Getting Started in MicroSurvey CAD 2005 

For clients who have had their original 90-day complimentary 
expire and feel that they will want on going support over the n
Yearly Support Contact option available.  This gives you the a
for technical support, as much as you require, and you pay a 
This option is not to b

support period 
ext year, we have a 
bility to contact us 
flat fee once a year. 

e used in place of training but is to assist you on the 
ge for the Yearly Support Contract is 

 paid for prior to the support commencing. This rate is subject to 

 our Internet Web-

ww.microsurvey.com/

occasions when you really need it.  The char
to be billed and
change, call for current rates. 
 
Electronic Support 
 
MicroSurvey maintains and provides support at no charge on
site at the following address: 
 
http://w
 

echnical Notes, 
Technical Specifications, and as required, free updates and program fixes, along 

ey Software Inc. can provide training to you, in your office or in a 
classroom situation (where facilities and numbers allow).  
 
MicroSurvey has training staff that will travel to almost anywhere and provide you 
with the professional skills you require to operate your MicroSurvey CAD 2005 
program.  Please feel free to call and ask for a quotation or inquire about 
potential classroom situations. Your local dealer may also be able to setup or 
arrange a training session for you.  Contact our head office for more information 
about training. 
 

This web-site has sections on Frequently asked questions, T

with a lot of other helpful information.   
 
Training 
 
MicroSurv
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VIP Support Program 
 
Keep on top of the technology with MicroSurvey’s VIP Sof
program. You don’t need to concern yourself about staying

tware Subscription 
 current – we’ll do it 

for you. It’s the worry-free way to ensure you always have the best, most up to 
here, and you know exactly how much it will cost. You’ll also 

o you automatically and 

 a real person 

ocess with a real 
(during regular business hours*)  

 We give you priority e-

urvey software 

e that a new upgrade 
Your upgrade will come automatically.  

hese days, you can 
ce, but that’s all you’ll pay for 

• Buy up to four years’ Subscription at once. You’ll know exactly what it’s 
 to check if you have the most 

current MicroSurvey software version.  
• We pay the shipping for new software. That’s another thing you won’t 

have to worry about.  
• When you deal with MicroSurvey, you always get great service. Imagine 

how good the service will be when you’re a VIP!  
 
Call our office for more details on the VIP program, or see the MicroSurvey web 
site. 
 
(*Note: 1 hour call back guarantee to start the support process is during Western Office hours) 

date software anyw
receive unlimited technical support for your software. 
 
What are the advantages? 
 

• Get all upgrades to MicroSurvey CAD 2005 sent t
Free!  

• Unlimited telephone support included. You always talk to
when you call MicroSurvey’s support line.  

• With VIP Service, we’ll always start the support pr
person within 1 hour of your call. 

• Always keep up to date with the latest technology.
mail notification of all bug fixes and updates.  

• You receive a 10% discount on your future MicroS
purchases (from regular or promotional pricing)  

• No need to generate new purchase orders each tim
is released. 

• Is your peace of mind worth pennies per day? T
hardly buy a cup of coffee for that pri
MicroSurvey’s VIP Subscription Program!  

going to cost you, and you don’t ever need



 

Copyright Notices 
 

rvey CAD 2005 

© Copyright 2005 

rove its products 
 fit. This publication describes the state of the product at the time of 

the product at all tim  future. Use and 
ment printed. No part 

t may be disclosed or otherwise made available without pr
authorization. 
 
MicroSurvey® is a Registered trademark of MicroSurvey Software Inc.  All other 
trade names or trademarks are gratefully acknowledged as belonging to their 
respective owners. 
 

MicroSu
 

MicroSurvey Software Inc. 
All Rights Reserved 

 
MicroSurvey Software Inc. reserves the right to revise and imp
as it sees

ior written 

publication, and may not reflect es in the
disclosure of this product is governed by a licensing agree
of this produc

6  Getting Started in MicroSurvey CAD 2005 



 

Getting Started in MicroSurvey CAD 2005 7 

Hardware Requirements 
 
MicroSurvey CAD 2005 operates entirely within Windows, and has no hardware 

elf except as noted below. We 
ent operation: 

 
 the better! 
king in large drawings 

olutions may result in 
own menus running off the bottom of the screen)  

eatures, your system will also 
need an external RS-232 serial port or a USB connection for best performance 

FieldGeniusTM. 

lotter configured to 
ining the most up-to-

er/plotter drivers off of the manufacturers Internet web site. 

requirements over and above those of Windows its
suggest the following basic system as a minimum for effici

• Pentium processor – 1000 MHz minimum – the faster
• 512megabytes RAM (1024MB or more if you are wor

most of the time) 
• 1 Gigabyte of free hard disk space 
• Video resolution set to 1024X768 or better (lower res

part of the pull d
• Mouse, digitizing tablet or other pointing device 

 
In order to use the data collector communication f

with MicroSurvey 
 
In order to get printed output, you will require a printer or p
work in your Windows environment.  We recommend obta
date print
 

Software Requirements 
 
MicroSurvey CAD 2005 is designed for use with Windows 98 (Second Edition), 
Windows ME,  Window NT (4.0SP5+), Windows 2000, or Windows XP
Windows NT,2000,  and XP users must have Administrator’s rights to authorize 
MicroSurvey.     
 
When using a digitizing tablet you will require the current WINTAB driver for your 
tablet, and it must be installed and configured in Windows. 
 

. Note: 
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Help System 
 
The help system is continually updated to keep current with
and new commands that ar

 all the advancements 
e added on a regular basis.  The help file also has 

one Numbers, Copyright Information, and Much more.  Be 
it will always be more current and 

 
A few
 
You a
 

dialogs within 
y CAD 2005. This will take you to the help topic on the 

Quick tips are available on most dialogs within MicroSurvey CAD 

enu or using the 
press F1 to jump to it in 

 
Have a look at the next image. The Help is arranged in the same basic order as 
the e
 

 Notice that the topic for drawing a LINE is displayed. If you had 
ons, you should flip to 
e menu system. 

 
• Notice that the keyboard command is shown where possible as well 

as the corresponding toolbox / Palette button. 
 

• The Back button will take you to the last page viewed and the forward 
and back arrows help you to navigate through the Help system in 
topic order as shown in the table of contents. 
 

• Always look for the vertical scroll bar on the far right hand side. It's 
presence indicates that there is more information below that is not 
currently visible. Some topics are several pages long! 

Tutorials, Important Ph
sure to look through the whole help file as 
comprehensive than the manuals. 

 tips about using Help: 

 c n find Help using any one of these 3 methods: 

1. By clicking on the HELP button available on most 
MicroSurve
command currently in use. 

2. 
2005 by using the What's This? Help.  

3. Access the Help System from the top of the Help m
F1 key.  If you have highlighted a menu item, 
the on-line help. 

M nus.  

•
located this topic using the Index or Search opti
the Contents option to locate the command in th
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What's This? Help  

The little  in the corner of the dialog box allows you to pick it then pick the 
portion of the dialog that you want help on while running the command. 
 
Use this to find out about any portion of the dialog box on screen. 
 

Getting Started in MicroSurvey CAD 2005 9 
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Installing the Program 
Please run Setup.exe o
Follow the prompts to in

n the CD to install MicroSurvey CAD 2005.  
tall the program. 

c. products, is 
u try out all its 

f the entire package by 
courage you to 

rm. This copy will be 

If you decide to purchase the system, you can convert it to full operation by 
means of a password supplied by MicroSurvey Software, or an authorized 
dealer.  
When you initially start up the program, you will see the following dialog box: 
 

s

The Convertible Demo 
MicroSurvey CAD 2005, like other MicroSurvey Software In
marketed in the form of a "Convertible Demo", which lets yo
functions without buying a copy. You can obtain a copy o
mail for a nominal shipping and handling fee; we also en
redistribute copies to anyone in complete and unaltered fo
fully functional in every way but will shut down after 30 days. 

  
 
Choose one of the following Options: 

Demo Mode 
If you are just testing the program out then you will click on the Start MicroSurvey 
CAD 2005 in DEMO Mode button. 
 
 
 



 

Register 
Step 1) 
If you choose Register Your Copy of MicroSurvey you will see the 
following dialog box: 
 

 
 
The program can be registered in two modes: 

• Stand Alone Installation 
• Network Floating License 

 
The remainder of this section will cover the Stand Alone Installation.  If 
you have purchased a Network Floating License, please see the 
document that was supplied entitled “Network Floating Licenses with 
MicroSurvey Products”. 
 
Step 2) 
Choose the Stand Alone Installation (My Computer Button) 
 
You will see the following dialog: 
 

Getting Started in MicroSurvey CAD 2005 11 



 

 
 
Step 3) 
 
Press the “Create Registration Form to FAX or Email button, and please 
fill in the following dialog: (we have entered sample information) 
 

 
 
 
Step 4) 
 
Press the “Generate Registration Text File” button and a document 
called “register.txt” will open in Notepad: 

12  Getting Started in MicroSurvey CAD 2005 



 

 

 
 
 
Step 5) 
 
Please print this document and FAX it to (250) 707-0150 or email it to 
register@microsurvey.com  
 

Getting Started in MicroSurvey CAD 2005 13 
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Step 6) 
 
For a Stand Alone Installation, you will be provided with a single 
number.  Only one number is required.  Please enter the number you 
are provided in the dialog: (sample number is entered) and press OK.  
 

 
 
Step 7) 
 
The program will advise you that the product will be registered the next 
time you start it up.  Exit the program and restart to make sure that you 
are no longer prompted for a password. 
 

Transferring License 
 
With MicroSurvey CAD 2005 we have introduced the ability to transfer 
your license to a different computer.  This is useful when you are 
upgrading to more powerful machines.  You will need to have access to 
both machines.  Both machines need to have MSCAD 2005 installed 
with one of the machines in a licensed state.  You will need to move a 
file from the “old” machine to the “new” machine.  This can be done with 
a floppy disk, network transfer, or USB memory key. 
 
Command: MSTRANSFER 
 
You will see the following dialog: 



 

 

 

 dialog.   

Take Home Option

 
Follow the instructions on the
 

 
 

Many MicroSurvey customers would like an easy way to transfer their office 
license to a home machine for evening or weekend use.  With MicroSurvey’s 
“Take Home Option” we have made that easy.  Here is how it works: 
 
• You transfer the license to your home machine by moving a file called 

transfer.lic via floppy disk, email, or a USB memory key. 
• The transfer.lic file has an expiry date in it.  If you copy the file onto a 

machine and run MSCAD before the expiry date it will work. 
• The expiry time is always midnight of the date. 
• You tell the program how many days you want to use it at home. 
• Today counts as “day 1”. 

 
Example: 
 
It’s Thursday and you want to work at home on Friday and Saturday, so you 
run the MSLICENSEFILE command.  On the following dialog, you enter 3 in 
the bottom right corner as shown: 

Getting Started in MicroSurvey CAD 2005 15 
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IMPORTANT NOTE: The program will no longer operate once you have 
exercised the Take Home Option.  It will work correctly once the home 
version has expired.  This is NOT reversible, so only use this option if 
you are certain that you will not need the office version. 



 

Program User Interface 

The desktop contains a series of standard elements. These are the menu bar, 
the toolbars, the properties bar, and the status bar. 

In addition, the desktop may also contain several palettes. 

The following picture shows a possible standard variant of the desktop. See the 
on-line help system for more details.  
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Desktop Configuration 
 
Command Line 
 
The command line can be placed at the top of the screen (below the menu bar), 
or at the bottom of the screen (above the status line). If you are an advanced 
user familiar with the program's command set, you might even turn off the 
command line. 
 
Properties 
 

 

The property bar can be turned on or off. We recommend you turn it on. 
 

 
Status Bar 
 

 

ar can be turned on or off. We recommend you leave it on. 

Customizing Toolbars 

 
The status b
 

 

 

The toolbars assemble buttons that represent a common set of commands, or 
 commands.  

 

sequence of
 



 

How MicroSurvey CAD 2005 Works 

nnectivity 
, bearings, and 

e CAD drawing by their 
iles are created to store this information.  

In order to limit the number of files you need to work with, we combine the data 
files into one file when you close the MicroSurvey CAD 2005 job. The database 

s stored wherever your CAD 
ored.  

ur job 
with the extension .MSJ. If you are running MicroSurvey CAD 2005 and you look 

e this .MSJ subdirectory.  
 the MicroSurvey CAD 2005 job by exiting or closing the drawing, 

then the files will be automatically compressed into one file, and the directory will 
e to 

 2005 has an Automatic backup timer that will save the drawing 
and the database regularly.  
 

the system will automatically 
be opened (very unlikely), then 

the system can still reconstruct the coordinate database and the connectivity 
database directly from information we store in the drawing.   
 
If you have only the drawing created in MicroSurvey CAD 2005 and no database 
for whatever reason, we can still recover coordinates from the drawing 
automatically upon opening the DWG file.  This can be accomplished by running 
the Audit database command.  See the on-line help for more information.   
 
 
 

 
MicroSurvey CAD 2005 creates a database that contains co
information, coordinate locations, descriptions, traverses
distances. The program tracks the entities stored in th
handle numbers. Many f
 

is stored in a file with the extension .MSD.  This file i
drawing is st
 
The MSD file is expanded into a directory that has the same name as yo

in the directory where your job is located, you will se
When you close

be removed. While you have the job open, the original .MSD file is renam
.MBK and it serves as an emergency backup file.  
 
MicroSurvey CAD

In the event that the .MSD file cannot be opened, 
attempt to open the .MBK file. If neither file can 

Getting Started in MicroSurvey CAD 2005 19 
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Workflow 
 
This summary is intended to provide an introduction to users who are not familiar 

 will be starting with data from a data collector, from field notes, or 

pen an existing 
ting drawing will 

ociated MicroSurvey CAD 2005 coordinate 
y CAD 2005 

ill be shown the Main 
e basic job 

e System Toggles to 
choices appropriate to the job.  Where you start next depends on the data 

 the MicroSurvey 

For data collectors you will either download directly from the data collector using 
the choices on the Data Collector Communication menu or reading a file from the 
data collector using the choices on the MsTraverse | Download Data Collector 
menu.  For field note entry you will use the Enter Traverse command on the 
MsTraverse | Traverse Entry / Editing menu.  For manually entered COGO data, 
you will use the COGO command from the MsCOGO menu. (you can simply type 
COGO if you wish as a short cut)  For point, line and curve data in a pre-existing 
CAD drawing, you will use the Auto Add Points to Objects command in the 
MsPoints menu.   
 
When you enter a traverse in MicroSurvey CAD 2005, either by downloading a 
data collector or by manually typing in the data, the program creates a traverse 
database.  Each traverse is contained in a separate database. The databases 
are stored in the project directory when MicroSurvey CAD 2005 is loaded and 
running, and they are automatically compressed into the .MSD file when 
MicroSurvey CAD 2005 is unloaded.   
 

with MicroSurvey CAD 2005 and outlines the steps necessary to prepare a 
survey drawing. 
  
Generally you
from direct COGO data entry. You may also extract data from existing CAD 
drawings.   
 
When you first start MicroSurvey CAD 2005 you must either o
drawing (dwg, or dxf file) or start a new one. Opening an exis
automatically open and link to the ass
database (.msd file). If you start a new drawing, a new MicroSurve
database file will be automatically created.  
 
On new projects or when you open existing projects, you w
Job Defaults. You should fill out the dialog box and set up th
information and scale factors.  Next you will need to set th

source. Most options can now be found on the Assistant or in
pull down menus.   
 



 

There is a set order that you should use when working with raw data 
information in MicroSurvey CAD 2005: 
 

1) Manually enter, load from a file or download the data into the traverse 

2) If you are entering the data manually, and the Auto Coordinate toggle 
wn onto the 

 download the data 
CII file will be entered 

oordinate database. The raw data shots read in 
ssed into coordinates 

by selecting MsTraverse 

 
tes into the coordinate 
averse. Use Store 

. 

oordinate Traverse. 
nd computes the 

coordinates for all the raw data shots taken in the field. 

 view the points. 

d Re-
coordinate the traverse.  When you run Re-coordinate traverse on a 
traverse that has already been coordinated, you will trigger a point 
protection alert for each point processed.  To avoid this, turn off Point 
Protection in System Toggles, then the entire traverse will then be 
process without interruption. 
 

8) To see the line work for the traverse go to the MsTraverse | Traverse 
Entry / Editing | Show Traverse Graphically command. 
 

9) Use the MsTraverse | Traverse Calculations | Compute Closure 
option to analyze the closure of the traverse. 
 

file. 
 

is ON, then points will be coordinated and dra
MicroSurvey screen as you enter the data. If you
from a data collector, any coordinates in the AS
immediately in the c
from the data collector ASCII file are NOT proce
until you select Re-coordinate Traverse. 
 

3) Edit the raw data to correct any known errors 
| Active Traverse Editor. 

4) Enter any starting setup and backsight coordina
database before you attempt to coordinate the tr
and Edit Coordinates on the MsPoints menu
 

5) Select MsTraverse | Traverse Calculations | Re-c
This is the program that analyzes the raw data a

 
6) Use the MsPoints | Active Coordinate Editor to

Examine the MicroSurvey drawing for errors. 
 

7) Correct errors using MsTraverse | Active Traverse Editor an
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10) You may balance the traverse using one of several options, Angle 

Balance. See Traverse Balancing in the on-line help for details. 

 can revert back to the 
 at step  

 
ee the Tutorials 

 

Fil
 
An wings. 
 
A sugg  in might be C:\JOBS2005.  Then 
crea mmend that you 
place er under MSCAD 2005.  
Also - not too many levels deep.  The 
job you can have many jobs, 
each w  new job or open an existing job, there 
are several files create
sele
 
Below y - using the file 
JOBN
 
Sta

Balance, Transit Balance, Crandall's, Least Squares, or Compass 

 
11) If you detect an error after balancing, you

original or edited traverse and re-coordinate it again starting

For more examples of MicroSurvey workflow, please s

es 

ou

te

nam

cte

nd

types used by MicroSurvey CAD 2005 

tline for how MicroSurvey CAD 2005 saves your dra

sted folder name to save your jobse
 a new one for 2006, etc. as desired.  We do NOT reco
your jobs in our MSCAD 2005 folder or in a sub fold
try and keep your folder names simple and 

e should also be kept simple.  Under this folder 
ith its own name.  When you start a

d automatically on the hard drive in the folder you 
d. 

 is an example of what files are created by MicroSurve
AME. 

ard Job Files: 
 File       jobnaDrawin me.dwg 

Dat d 
 
Temporary Folder    <dir> jobname.msj 
 
Backup of Drawing file   jobname.bak 
Backup of Database file   jobname.mbk 
 
Note that for MicroSurvey CAD 2005 you can set the program to store all files in 
DWG format from R2.5-R2005.  
 
When the Job is opened, the Drawing file goes into your computer memory, and 
the Database file is opened into a temporary folder.  The temporary folder has 
the same name as the JOB but has an extension of MSJ attached to it. 
 

g
abase File       jobname.ms



 

You laced in here except via 
the automated routines in our program.  We place this temporary MSJ folder in 
th y you cannot open a 
job f ot have enough 
sp
 

ents of this folder are compressed and saved 
 along with 

t place anything in this folder 

ation in memory and 
s of the MSJ folder 
 MSD file already 

rive.  The DWG file 
file becomes the MBK file.  This way you 

BAK file and MBK file 
y exist then they are simply replaced by the newer copy. 

roug  a jo ou other files as well.  The LOG file is 
tom ticall in th am the DWG file.  This file maintains a 

e urve  com e is a toggle to control 
e ility to blank 

rk  the you decide to save your surfaces 
the same folder as the 

s QSB file is not automatically saved and must be done 
ime you wish to use it 

The program will also save Raster functions in the FLI file and any Helmert's 
Transformation data sets in the HELMERTS.BIN file. 
 

should not touch this folder and nothing should be p

e same location on the hard drive as the job. This is wh
rom your floppy drive as it is too slow and does n

ace! 

When you save the job, the cont
into the MSD file. If you exit the program this folder is erased,
everything in the folder. This is why you should no
yourself.   
 
Each time you save the job you are taking the current inform
saving it to the DWG file.  Then we take the current content
and save it to the MSD file.  At the same time, if a DWG and
exist then we rename the copy already on the hard d
becomes the BAK file, and the MSD 
have backups of your work in case you need them.  If a 
alread
 

ork As you w th h b y  will create 
saved au a y e s e folder as 
record of th s y mands run with their output.  Ther
this file as w ll as the ab the file.   
 
If you do any wo in  Modeling menu and 
then you will create a QSB file.  We suggest you save it in 
DWG file as well.  Thi
manually - also for loading it must be done manually each t
in the job. 
 

  
 
Other files can be generated, depending upon what you do in the program.  If 
you download a data collector you may have a Raw data file or a Coordinate file.  
You must tell us where to save these files on the hard drive and in some cases 
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even what to call them.  We might suggest one of two locatio
files.  First might be a folder called C:\DOWNLOADS, it w
level

ns to place these 
ould be at the same 

 as JOBS2005 but separate.  Second you may want to place the 
g,  

your download files.  This 

names may be sent 
l require you to 
ame then be sure that 

n it. 

ata files and COR or TXT or ASC 
 and CR5 for 
ctor automatically)  Or 

roSurvey, they can 
e files, to ASCII exported files and upload 

 these anything you 
tent and use 

 the JOBS2005 

have the ultimate control and if you do not know how to work in Windows to 
me training in this area 

 

DOWNLOADS folder under the JOBS2005 folder producin
C:\JOBS2005\DOWNLOADS as a location to save all 
is up to you.  
 
Depending upon what type of collector you are using, the file 
directly from the collector to our program.  Other brands wil
provide the name and extension.  If you are providing the n
it reflects your job name, is unique and has an extension o
 
Suggested extensions might be RAW for raw d
for coordinate files.  (TDS collectors use RW5 for raw files
coordinate files, and both use the name stored in the colle
course there are many other files that you can create with Mic
range from Report files and closur
collector files, and even Legal Descriptions.  You can name
desire but we recommend that the naming structure be consis
appropriate extensions, and always keep the files together in
folder so you know where the files are.  We allow you a lot of flexibility but you 

create the correct folders then you may wish to receive so
before jumping in too deep. 
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MicroSurvey Assistant 
 

These menus are designed to assist you in developing a job f
to completed survey drawing, with minimal knowledge by th
 

Assistant Main Menu

rom first principles 
e user.  

 
 
The main menu is structured so that no matter what you ha
you should be able to do it directly from here.  
 
As you move your mouse around on the assistant, you wil
appear for each of the buttons.  They are there to help y
button will do for you.  Picking on one of the buttons will ta
level of menus that provide more programs.  Investigate the
where to find what you need. 

ve to do to start a job, 

l see different pictures 
ou remember what each 

ke you to a second 
m all so you will know 

 

 
 
 
 



 

Assistant - Set Program Defaults 

Use this dialog to modify the 
efaults. 

Defaults under the General 

tup 
such things as distances, 
elevations, point numbers, 
etc.  The CAD Settings and 
Drawing Units will display the 
appropriate options allowing 
you to set the working units, 

 
  

Program D
 
You can modify the Main Job 

button.  The Toggles are also 
available to you from this 
dialog, along with all the 
other defaults used to se

grid, snap, point style, 
OSNAPs, trim radius, 
highlighting options, mirror 
text options, and a whole lot 
more.   

 

 
 
 

Assistant – FieldGenius Tools 

MicroSurvey’s FieldGenius 
line of data collectors has a 
super productive and easy to 
use interface. Our extensive 
experience with a variety of 
manufacturer’s data 

 

collectors ensured that when 
we built an interface, it would 
be better than anything on 
the market. Our ActiveSync 
integration makes data 
transfer and import as 
painless as possible. 
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Assistant - Send/Receive Data fro
 

m Data Collector 
 
 

 

This short menu assists 
are downloading a file fr
data collector to the co
uploading a 
to your data collector. 

you if you 
om your 

mputer or 
file from the computer 

 
 
 

Assistant - Import ASCII File or DC File 
 
  

 of importing point 
urvey CAD 2005 
le.  This file would 

ike; Point 
gs, Eastings, 

riptions, each 
, and in one of 
rmats in a text 

ASCII file. 

 read a dat
 downloaded 

previously, incorporating the data 
into your job. 
 
Several other tools have been 
added to this menu to allow you to 
join points by linework in an 
automated method.   

Another method
data into MicroS
is via an ASCII fi
have information l
Numbers, Northin
Elevations, Desc
describing a point
several different fo
file known as an 
 
You can also
file that you

a collector 
 

 



 

Assistant - Traverse Calcs 

This menu option allows you to 
manually enter, edit
coordinate, or show
also allows 
closures and balanc
 
Data collector files are also 
considered to be traverses and 
therefore you have the ability to 

 well.  
Especially useful for the data 

ordinate 
s required to 

m the 
ed in your 

 

, list, re-
 a traverse.  It 
mpute 

e the traverse. 
you to co

manipulate those files as

collector file is the Re-co
traverse option which i
calculate coordinates fro
original Raw data sav
data collector files.  

 

As ulating Programssistant - COGO/Calc  
 

rtcuts used 
OGO 

f the most used 
ey CAD 

s 
ting 

and 
then taking those streets and 
adding blocks and lots to 
create a subdivision.  Finally 
this section allows you to 
take the lots and place 
houses on them, with 
labeling of the lot numbers 
and areas.   

Here are the sho
by almost everyone.  C
is one o
portions of MicroSurv
2005.  Working with line
and curves, genera
streets from centerlines, 
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A ring/Volumesssistant - DTM/Contou  
 
 

 need t
take their survey drawings a step 

urfaces from 
ta, we have 

 to the 
 as seamless as 

mmon 
urfaces, 

 continuing 
alculate volumes 

es, are all 
ere along 

ptions. 

For the customers that o 

further and create s
the point and line da
made the transition
Modeling program
possible.  The more co
activities of creating S
TINs, Contours, and
further to c
between multiple surfac
made available to you h
with many other o

 
 

Assistant - 3D Design Programs 
  

sed for the more 
sign sections of 

D 2005. These 
es are explained in detail in 

the Help system. 

This menu is u
advanced de
MicroSurvey CA
routin
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Assistant - Label Drawing 
  

t to all of 
routines.  

oxes can be 
ake rapid 

ther routines 
e tables and 

re added to 
es, or 

can be left on the screen for future 
usage.   

This menu is a short cu
your text and labeling 
Many of the Toolb
accessed here to help m
labeling possible.  O
such as line and curv
area calculations a
assist you.  The toolbox
palettes, display many options and 
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Data Collector Tutorial 
 
 
B plexity o n into 11 
sm sier for you to follow. 
 
S
 
Step 2) Importing a Data Collector File 
 
Step 3) Viewing the Drawing 
 
Step 4) Line Connection – Z-coding 
 
Step 5) Create Surfaces 
 
Step 6) 3D Viewing and Advanced Rendering 
 
Step 7) Cleanup of Screen 
 
Step 8) Quick Contours 
 
Step 9) Setting up a Boundary 
 
Step 10) Final Contours 
 
Step 11) Labeling Contours and Saving Your Work 
 

ecause of the size and com
aller steps to make it ea

tep 1) Starting the Job 

f this tutorial we have broken it dow



 

Starting the Job 
 
In this introductory tutorial we will load a data collector file and annotate the 
points, connect the break lines, then build a contoured topographic model of the 

e will start with a new empty drawing and project and build 

 drawing by going to the File Menu and executing the 

n on the Project Manager: 

surveyed site.  W
everything from scratch. 
 
To begin, start a new
Project Manager command. 
 
Pick the New butto
 

 
 

Then fill in the name of the job and call it SOKKIA.DWG,  
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Pick on the Save button. 
 
Next you will see the following dialog box. 
 
Set the scale and other settings as shown below. 

 
 
Pick on the OK button to continue. 
 

 



 

Importing a Data Collector File 

 the MicroSurvey Assistant on scree
tton from the option bar) 

 
You will see n (if you do not, pick on the 
Assistant bu
 

 

Import ASCII File or Data Collector File 
 
From the assistant pick the 
button. 
 

 

Then from this dialog 
pick the Import Data 
Collector ASCII File 
button. 

 
 
 
 

 

34  Getting Started in MicroSurvey CAD 2005 



 

Getting Started in MicroSurvey CAD 2005 35 

 
 
Now select the button that says Sokkia 20/22/24
 

. 

You will then be pr oggle Check dialog box to confirm 
that they are corre em if required. 
 

esented with the T
ct or to change th

 

 button to continue. 
you will see the following dialog. 

 
Pick the OK
Next 



 

 
 
Change it to the \MSCAD 2005\Tutorial folder and p
SOKKIA.RAW. 

ick on the file named 

 

 
 
Then pick o ntinue.  This is a Sokkia coordinate 
data colle
 

 

n the OPEN button to co
ctor file. 

Then you will see the following dialog box: 
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Select New Traverse
Enter Sokkia as the ne
pick the SAVE button to continue. 
 

, because this is a new traverse database.   
w traverse name in the following dialog box, and 

 

 dialog box below and then pick the 
 
Fill in information about the job in the
OK button. 
 

 
 
This collector file contains only coordi erefore all 
the points are passed directly through to the database and screen. As the 

ector records scroll by in 
 

screen. 

nate information and th

data points are loaded, you will see the data coll
the text window, but because the view is not over the site, you don’t see
anything until the end when the program automatically does a zoom 
extents for us.   
 
You will see this dialog box in the middle of the 
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Pick on NO 

 

. 
 
And NO

EXIT on each 
one until they are removed from screen and you are left with just the job 
on screen.  

 

 
Then when the Assistant menus come back on screen – hit 
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Viewing the Drawing 
 the tutorial is to help show the points in the job in a view that 

will help you understand the program.  This entire step is not required 
 doing your own jobs later) 

 
You will see all of the labeled points from the job.  If you zoom in on a 

ints, they would look like this.  

(This step of

when

couple of po
 

 
 
(The zoom commands are found on the left side of the scree
 

n) 

 
 
The annotation (text) is drawn at the current elevation (usually zero), but 
the points are drawn at their actual 3D elevation.  You can se
looking at your drawing from an oblique view. 
 
Let’s set our drawing to an oblique view. Run the Preset Viewpoints… 
command, found in the View drop-down menu. You will se
 

e this by 

e this dialog: 
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his is the ISO View SW button): Now press this button (t
 

 
 
Then Press the OK button. 

 
You will see from this oblique view that the points are at their elevation 
towards the top of the screen and the annotation is at an elevation of 
zero.  



 

 
 

p View (Plan View) icon button found in the 3D View… Now pick the To
command, to return to a normal view. 

 
 

 

Line Connection – Z-coding 
We are going to connect points sharing the same description with 3D 
break lines, so let’s create a layer on which to place them.  Select the 
layers icon in the bottom left portion of the screen, as shown here. 
 

 
 
Make a new layer called "lines" and make it current as follows: 
 
The window opens to the Layers table.  Pick the New button at the top left 
end of the toolbar, and type in LINES.  Pick the small blue check mark to 
make the LINES layer the current layer.  In this case I set the lines layer 
color to black (255) by picking the small box to the right of the layer 
name.  Close the IntelliCAD Explorer window. 
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AP System  

 

From the MsTraverse pulldown menu, select AutoM
Connect Points by X Y Z,  and you will see 

 
 

topographic surface, so pick 
the 3D Lines button.   

d then you will see 

We will be using these as break lines for our 

You will see some linework being drawn on screen an
the following dialog box. 
 

 
 
The data collector file in this example uses Z coding to allow for fast 
automatic connection of points with lines.  Normally, you would blank the 
description codes to remove the leading Z character, but for this demo, 
answer NO to blank description codes so you can see them. 
 
Now your screen should look like this.  The lines you see are in 3D, just 
like the points that were used to create the lines. 
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C
 

reate Surfaces 
 

ve points and break lines, which is all you need for a topo 

ch to make our map by using the Data 
Extraction filters in the Modeling routines.  This allows us to be very 
specific on what we are using to create our surface.  You do not always 
need to use the filters but doing so allows you full control. 
 
Go to the MsModeling pulldown menu and pick on Configuration 
Settings. 
This dialog will appear: 

 

Now you ha
map and surface. 
We will extract the data from whi
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Data Extraction button and this dialog box comes up. 
 

Pick on the 
 

 
 

Pick on the Filter by Entity button and then pick OK to continue, and OK 
again to exit the previous dialog. 
 
Next go to the MsModeling pulldown menu and select Extract from 
Drawing  Extract to Surface.  You will see the dialog box shown here.  
Accept the surface name of Ground and pick the OK button to continue.   
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 to create your surface.  
pick the SELECT button 

and then the OK button to continue. 
 

 
Now you will be asked what it is you are picking
On this dialog pick POINT from the list – then 

 
 
Next select the points, by windowing the entire drawing, or simply press 
ENTER and the routine will grab everything in the drawing automatically 
for you.  Don’t worry if you get the break lines too as we have told it to 
filter out just the points at this time.   
 
264 points total in surface.  

 
You have now placed all the points on the surface Ground.  Now we need to do 
the same thing with the breaklines. 

 
Pull down the MsModeling menu and select Extract from Drawing  
Extract Breaks. This will show the following dialog box, similar to the one 
above.  
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Pick OK to accept the surface name Ground.  Both the points and 
breaklines must be on the same surface.   
 
Now you will see the following dialog box. 
 

 

LYLINE and LW 
lyline, as shown below.  

 
Pick on the RESET button and then pick on LINE, PO
Po
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SELECT button.  What you are doing is telling the 
you no longer wish to pick points but now wish to pick lines 

m as breaklines to your surface. 
 button to continue. 

ect the breaklines by making a window around the 
drawing, or by simply pressing ENTER to select everything on screen.  
Don’t worry if you get the points too as the filter will only use the 3D lines 
and polylines it finds. 
 

179 additional points added to current surface. 
 
Note: The order is important here.  Extract points first, then breaks.  This 
puts the extracted data into a surface named what you decide.  The 
default is GROUND.  We don’t see anything yet because we just created 
a surface in memory, but have not displayed it. 

 

3D Viewing and Advanced Rendering

 
Then pick on the 
routine that 
and polylines to add the
Then pick on the OK
 
Now you can sel

 
 

Most of the time you would just create and draw contours at this point, but 
we will take a two-minute side trip to explore basic site visualization in 3D. 
To start with, we are going to create and draw a TIN (Triangulated 
Irregular Network) representing the topography by selecting TIN from the 
MsModeling menu -> TIN Create/Edit option, pressing return to select 
the <GROUND> surface and then answering D to Draw the surface 
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(rather than the temporary Show) an
ace mesh entity with invisibility as 

 the points and breaks of

Here is what you should now see. 

d press return twice to draw it as a 
polyf NONE.  This is the 3D surface 
representing  the surface. 
 

 
 

 

Cleanup of screen 
 
We will erase the TIN from the screen so we can see the rest of the job.  We will 
use a shortcut to do this.  Press an E (for erase) followed by <enter>, then when 
prompted to select objects, answer L <enter> to select the last object drawn, 
then press <enter> again.  MicroSurvey has shortcuts called selection sets like 
Last and Previous that can speed your work. 
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(If the Tin does not erase then try again and pick one of the triangles while in the 
er
 
Occasionally you may need to redraw the display in MicroSurvey to clean up 
artifacts from erasing entities.  

ase command) 

 
Pick the redraw button on the left side menu to run the redraw command. 
 

 
 

 

Quick Contours 
 
Contours may be generated by three different methods.  To set the correct 
method for what you require we need to do 2 things.  First we need to set the 
color map to what we require.  Go to the MsModeling pulldown menu  
Options  Reset Color Map. 
 

Color 

 
 
Pick on the RESET button and then the OK button. 
What this is doing is setting the colors to standard CAD colors so you can set 
your pen widths for plotting easily. 
Now we need to tell the routine which method to use to color the contours and to 
set the interval. 
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Go to the MsModeling pulldown menu  Color Options  Contour Color 
Settings 
 

 

Set your defaults to match 
 

 
We will draw our contours on their own layer. Make a new layer named contours 
and make it current, just like you did for the lines layer previously.  Pick the Layer 
Managemen  the Explorer 

.  Highlight the 
CONT on to make it current. You can 
also double he 
Explorer. 
 

this dialog

t button.  Pick the new button at the top left end of
toolbar. Type in CONTOURS in the edit box and press Enter

OURS layer and pick the blue check butt
click on the layer in the Explorer to make it current. Close t

 
 
Select the Contour command from the MsModeling pulldown menu, press 
<enter> to accept the <GROUND> surface (the surface to which you extracted 
your points) and press <enter> to temporarily “show the contours". 
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The contours are NOT yet part of the drawing.  They are only in memory and 

n, such 
as pan or zoom or redraw.  If there was a problem with a bad elevation, you 
could fix it before drawing permanent contour lines. 
    

Setting up a Boundary

displayed temporarily. 
 
The contours are displayed temporarily until the next refresh of the scree

 
 
Most of the time in a topo survey you will take shots outside of the actual 
property lines for control, but you may only want to display contours within the 
property outline.  We will do this by setting up and using a boundary.  A boundary 
acts like a Trim line, cropping the contours so they do not pass over the polyline.  
We will add a boundary polyline, then draw and label contours for this site. 
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Draw a polyl

contours.  (

ine similar in shape to the bold line shown below to use as a 
boundary.  This line might represent a property line or an arbitrary trim line for the 

Your polyline will not be bold by default.  We made this one bold so 
you could see it easily.) 

 
 
If you are unfamiliar with the polyline command, type PL then left click on each 
location where you would like a vertex, then finish by typing a C to close the 
polyline into a closed polygon suitable for a boundary.  (See the MicroSurvey 
help for more information). 
 
Select this polyline as a boundary, by running the Boundary Options  Set 
Boundary command from the MsModeling pulldown menu and selecting the 
polyline boundary you just created.  Press <enter> to complete the selection.  
Now the contours will be limited to within this boundary, when we run the contour 
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command again to draw them. (See the help file for more on
including nested boundaries) 
 

 boundaries, 

Refresh the screen by picking on the redraw button on the left side menu. 
 

 
 
The contours disappear because they were displayed temporarily with the show 
command.   Now we will draw them permanently, honoring our new boundary. 
   
Final Contours 

 
Select Contour from the MsModeling pulldown menu, press <enter>
the <GROUND> surface (the surface to which you extracted your points) and 
type D at the command line, and NO to the Close All prompt.  
 
You will now see the following on screen. 
 

 to accept 
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The drawing is getting cluttered, so let’s turn off all layers except the Contours 
layer.  Go to the MsTools   Layer Control  Isolate.  Then pick on one of the 
contours and press <enter>.   
 
What you are left with is this: 
 



 

 
 

Erase the polyline we drew for the boundary, as it is no longer needed, because 
the contours are now drawn and trimmed. 
 
Type E enter and pick the boundary polyline, then press enter. 
    

Labeling Contours and Saving Your Work 
 
Zoom in on the steep slope in the NW part of the site.  To zoom window, press Z 

<enter> W <enter> and specify two corners. (Or, you can use the  button on 
the left side of the screen to zoom window.) 
 
The black box in the image below shows you where to pick for the Zoom Window 
command. 
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Annotate  Label Contours from the MsModeling pulldown menu.  You 
will be prompted for a text height.  You may specify one graphically by clicking on 

o indicate the text height,  or enter a number.  In this case a height of 
d. 

 
Select 

the screen t
2.5 was use
 

and the labels will be placed and 

Next you will be repeatedly prompted for label locations.   
 
Click on contours where you would like labels, 

to trimmed as needed. the con urs 
 

 
 
NOTE: To label many contours in a straight row, draw a polyline across the 
contours where you wish to have them labeled.  Then run the Label Contours 
command again – this time after giving the text height, pick the CONTROL button 
found on the option bar.  Then by following the prompts, select all the co
label (be sure to not pick the polyline to be used as control lines to label 
After picking all the contours to be labeled – press enter.  Then pick the control 
polyline and you should see the labels start to draw on the contour lines exactly 
where the control polyline intersected them.  The Control polyline is automatically 
removed from the drawing. 
 

ntours to 
along).  
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Example: 
 

 
 
Now lets Zoom to the Extents of the drawing to see everythi

Type Z <enter>
ng on screen.   

 then E <enter>, or pick the .button. 

Now we are going to Smooth the contours.  Go to the MsModeling pulldown 

Either pick the contours to smooth or simply press <enter> to select them all 
automatically. 
 
After smoothing your diagram should look like this. 
 

 

menu  Annotate  Smooth Contours. 
 

 
 
 
Now save your job by picking the save command on the file menu.  You also 
need to save the surface by going to the MsModeling pulldown menu  
Surface Operations.  Pick the surface name on the left side of the dialog and 
then select the Write QSB button. 
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Set the folder to Jobs2005, the same location we started the job.  Do not place 
the file in the SOKKIA.MSJ folder.  Enter the name SOKKIA and press the SAVE 
button. 
 

 
 
Pick the OK button on the previous dialog to continue 
 
Your surface is now saved along with the drawing and the database.   
 
You may now exit the program via the File pulldown menu. 



 

 
Simple Traverse Tutorial 
 
 
Because of the size and complexity of this tutorial
smaller steps to make it easier for you to follow. 
 
Step 1)  Starting the Job 
 
Step 2)  Setting the Defaults 
 
Step 3)  Manual Traverse Entry 
 

 we have broken it down into 9 

p 5)  List of Data to Enter 
 
Step 6)  Coordinating the Traverse 
 
Step 7)  Computing Closure 
 
Step 8)  Adjust Angles + Compass Balance 
 

Step 4)  Start Entering Shots 
 
Ste

Step 9)  Listing the Traverse 
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Starting the Job 
 

rse around a farm. 
 corners of the boundary, and to locate a 

m.  
 

shed product will look like. 

 

In this cookbook-style tutorial we will enter a simple 2D trave
This traverse was done to locate the
building on the far

Here is what your fini
 

 
 
Overview: 
The surveyor began by setting up on one corner of the farm property and 
assigning a coordinate of North = 1000, East = 1000, Elev = 0, Point number = 1. 
He then backsighted an iron bar with a known direction of 214 degrees 12 
minutes, 15 seconds. Since he could not directly set up on all the bars on the 
property because of rocks, hedges, and fences, he traversed around the property 
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taking side shots into the corners. On the traverse, he also
of a shed. 
 

 located three corners 

To Begin: 
To begin, start a new drawing by running the New … command, found under the 
File drop-down menu. 
 
Pick the New button on the Project Manager, and filll in the name of the job and 
call it FARM-A. Then pick Save to continue. 
 

 
 
Next you will see the General Configuration Options dialog box. 
 
Set the scale and other settings as shown below. 
 

Setting the Defaults 

wing as show
00’.  Do not pick the OK 

 

 
Once the new job opens you will be asked to fill out the follo
setting the units to Feet, Azimuths and the scale to 1=5
button yet! 

n, 
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lts dialog box 
 

 

Main Job Defau

From the bottom of this dialog box, select the Toggles button
Toggles as shown in the 3 Figures below. 

. Set the System 
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Sy
 

 the previous dialog – and press the OK 
button again
   

stem Toggles dialog boxes 

Now press the OK button to return to
 to continue. 

Manual Traverse Entry 

your screen should now look like:
e Assistant button from the main Mi

bottom of the screen, or type Assistant at the co

 
This is what  (if the Assistant is not on screen 
then pick th croSurvey CAD toolbar near the 

mmand line and press Enter. 
 

 
 
Next, from t
 

he Assistant, pick the Traverse Entry / Edit / Adjustment button: 

64  Getting Started in MicroSurvey CAD 2005 



 

Getting Started in MicroSurvey CAD 2005 65 

 
 
Pick the Enter Traverse Field Notes button.  
 

 
 

Pick on the New Traverse button 
 
MicroSurvey will respond with a dialog box for you to enter your job name. Enter 
FARM-A in the dialog box as shown below: 
 



 

 

Pick the ou will be prompted with a dialog box to fill 
out with info
 

 
SAVE button to continue.  Y

rmation about the traverse: 

 
 
Pick OK and then you will be asked: 
 

 
 
Answer this NO, as we will use the normal dialog boxes to enter the traverse.   
 
Answer Yes to the following dialog, so we start entering data with dialog boxes: 
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We will work with the dialog boxes so answer 
 
Now you are asked to enter the info
appropriate backsight information. 
We have a Setup Point of 1 with co
the Setup Point Number as 1 and t
point number.  Fill in the new Dialog as shown b
NOTE: Use the TAB key to move bet

YES to this. 

rmation for your first setup station, with 

ordinates of N=1000, E=1000, Z=0 so enter 
hen pick the EDIT button to the right of the 

elow and pick Ok to finish. 
ween fields: 

 

 

50 seconds from where 
ox, as shown below: 

(Leave the other entries as shown) 

 
We have a backsight azimuth of 214 degrees 12 minutes 
we set up, so a backsight azimuth of 214.1250 in the edit b
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Now pick the OK button to continue. 
 
The program will go immediately into the data entry mode.  
   

Start Entering Shots 
 
Enter the first shot information into the dialog box as shown below. 
 

 
 
(If the above dialog asks for Vertical Angles and Slope Distances instead of the 
Horizontal Distance and Vertical Distance, then you did not set the system 
toggles corr Mode, change the Toggles to 

art the traverse entry over again) 
Pick the  to continue 
 
The program will compute the coordinate and display the information in a dialog 
box: 
 

ectly.  Exit out of the Traverse Entry 
match what was given earlier and st

OK button or press <enter>
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 to accept this information.  

y allows you to switch back and forth between entering traverse legs 
 side shots at any time. We will enter the traverse and side shots 

s entire manual with screen shots showing the information to 
e are going to list the shots and setup information to enter.  

w setup, just pick Next Setup or press Esc at the Enter Correct 
ox.  The program will return to the setup dialog box.) 

 entered from the same 
ed to traverse forward to 

ng. 
eyboard to return to 

 

Pick OK
 
MicroSurve
and entering
together. 
 
Rather than fill up thi
type into this tutorial, w
(To start a ne
Data For Shot dialog b
 
At this point you will be asked for the next side shot to be
setup.  We have no more shots from this setup so we ne
the last shot we just finished enteri
Pick the Next Setup button or press the Esc key on your k
the Enter the Setup Information dialog box. 

 
 
   



 

List of Data to Enter 

ce it has aut
backsight point number 

 
You will noti omatically updated the setup point number and the 

with the following data: 
 

sight 1. 

ou can enter the next Shot 

ept the calculated 

Next pick the Next Setup button to go back to the setup dialog box. 
 
Set up on Point 8 and backsight 7. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 

Vertical Dist
umber :2 

Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :231.5652 
Horizontal Distance :302.5 
Vertical Distance : 0 
Point Number :9 

Set up on Point 7 and back
Pick the OK button to accept these values. 
 
Now y
 
Horizontal Angle :131.0316 
Horizontal Distance :248.31 
Vertical Distance :0 
Point Number :8 
Description : 
 
Pick the OK button to continue.  Press the OK button to acc
coordinate. 

Horizontal Angle :134.2554 
Horizontal Distance :83.92 

ance :0 
Point N
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Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated 

go back to the setup dialog box. 

cksight 8. 
 to accept these values. 

ollowing Shot: 

ntinue.  Press the OK button to accept the calculated 

t Setup button to go back to the setup dialog box. 

n Point 10 and backsight 9. 

 
 :203.2344 

e :60.18 
: 0 

r :3 
 

 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :86.3210 
Horizontal Distance :312.35 
Vertical Distance : 0 

coordinate. 
Next pick the Next Setup button to 
 
Setup on Point 9 and ba
Pick the OK button
 
Enter the f
 
Horizontal Angle :237.1721 
Horizontal Distance :341.71 
Vertical Distance : 0 
Point Number :10 
Description : 
 
Pick the OK button to co
coordinate. 
Next pick the Nex
 
Setup o
Pick the OK button to accept these values. 
 
Enter the following Shot: 

Horizontal Angle
Horizontal Distanc
Vertical Distance 
Point Num
Description :

be
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Point Number :15 
Description : 

OK button to accept the calculated 

Next pick the  button to go back to the setup dialog box. 

d backsight 10. 
 accept these values. 

lowing shot: 
 

Vertical Distance : 0 

ntinue.  Press the OK button to accept the calculated 

 button. 

 following Shot: 

tal Angle :317.1045 

 0 
Point Number :12 

Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :300.1321 
Horizontal Distance :38.54 
Vertical Distance : 0 
Point Number :13 
Description : 

 
Pick the OK button to continue.  Press the 
coordinate. 

Next Setup
 
Setup on Point 15 an
Pick the OK button to
 

 folEnter the

Horizontal Angle :123.1746 
Horizontal Distance :40.19 

Point Number : 4 
Description : 
 
Pick the OK button to co
coordinate. 

he Next SetupDo NOT Pick t
 
Enter the
 
Horizon
Horizontal Distance :56.92 
Vertical Distance :

Description : 
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Pick the OK button to continue.  Press the OK button to a
coordi

ccept the calculated 

287.3017 
e :51.68 

: 0 
14 

tion : 

Next Setup button. 

 Shot: 

gle :258.1506 
Distance :658.78 

Vertical Distance : 0 

 
on to continue.  Press the OK button to accept the calculated 

 Next Setup button to go back to the setup dialog box. 

Set up on Point 16 and backsight 15. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :131.4731 
Horizontal Distance :69.42 
Vertical Distance : 0 
Point Number :5 
Description : 
 

nate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :
Horizontal Distanc
Vertical Dista

ber :
nce 

Point Num
Descrip
 
Pick the OK button to continue.  Press the OK button to accept the calculated 
coordinate. 
Do NOT Pick the 
 
Enter the following
 
Horizontal 

tal 
An

Horizon

Point Number :16 
Description : 

Pick the OK butt
coordinate. 
 
Next pick the
 



 

Pick the OK button to continue.  Press the OK button to accept the calculated 

Next Setup button. 

hot: 

: 6 
ngle :264.1350 

Horizontal Distance :  

 
 to continue.  Press the OK button to accept the calculated 

ext Setup button to go back to the setup dialog box. 

Setup on Point 6 and backsight 16, and   

setup point: 
 

 0 

 button to continue.  Press the OK button to accept the calculated 
te. 

 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 21 and backsight 6. 
Pick the OK button to accept these values. 
 
Now take the final shot to the closing foresight point. This is the starting 
backsight point. 
 
Horizontal Angle :139.3500 
Horizontal Distance :100 

coordinate. 
Do NOT Pick the 
 
Enter the following S
 
Point Numbe

l A
r 

Horizonta
695.37

Vertical Distance : 0 
Description : 

Pick the OK button
coordinate. 
 
Next pick the N
 

Pick the OK button to accept these values. 
 
Enter the following Shot that is back to the original 

Horizontal Angle :273.5655 
Horizontal Distance :1399.37 
Vertical Distance :
Point Number :21 
Description : 
 
Pick the OK
coordina
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Vertical Distance : 0 
Point Number :31 

 to continue.  Press the OK button to accept the calculated 

Next Setup button to go back to the setup dialog box. 

oncludes the survey data entry. You can exit by picking the CANCEL 

   

Description : 
 
Pick the OK button
coordinate. 
 
Next pick the 
 
This c
button. 

Coordinating the Traverse 
 
You should be back to the assistant menu shown below: 
 

 
 
We are going to Edit your Traverse Data to ensure you have not made any 
mistakes in entry 
 
Pick on the Edit Traverse Data button. 
 
You will see the following Summary: 
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window. 
 

t to see the rest of the listing as shown 

Close the Assistant dialog that appeared on top of the 

Scroll down using the bar on the righ
below: 
 



 

 
 
(If you do have errors then you can edit the entry and make the correction now.) 
 
Select Re-coordinate Traverse from the Edit Menu on the Active Drawing 
Editor.  Or you can type Ctrl-R if the editor window is current. 
 
You will be given the option of creating a Re-coordination Report or Log.  Accept 
the defaults as shown: 
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After the traverse has been coordinated you will be returned to the Assistant.  
EXIT button to leave the Assistant. 

Next go to the MsTools  Print / Edit / View Reports  View Log command:

 the following Window appear. 

Pick the 
 

 
 
You will see

 
 
You may pri  pulldown menu on this window, 
and pick the
 
Pick the 

Pick the Zoo

nt this report now by going to the File
 Print command. 

X in the top right of the window to close it. 

m Extents Button on the right of the screen,  
 
Now your screen should look like this: 
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Save the project by entering the SAVE command. 

Computing Closure 
Now we will compute the closure error.  Select the 
bar, then pick the Traverse Entry /Edit/ Adjustment
Compute Traverse Closure button.  You will be asked: 
 

ASSISTANT from the option 
 button.  Then pick the 

 
 
Pick the YES button to continue. 
 
Now you will be asked if you have a Closed Loop or Open traverse. 
 

 
 



 

Select 
foresight on 
 
MicroSurve

ches 
the first of th
 

Open Traverse, because we have an external backsight and closing 
this traverse. 

y quickly analyzes the traverse and finds the last instrument setup 
point number. It offers this as the closing point number:  Our traverse mat

e 3 scenarios presented: 

 
 

ntinue. 

t 21: 
 

Pick the OK button to co
 
You will be shown the calculated coordinates of poin

 

You must change these to reflect the true coordina
To make this easy for you pick on the button marked 

up another dialog that allows you to enter in the 
ect coordinates for point 21. 

 
tes of point 21.   

Copy. 
 
This brings point number that 
has the corr
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21 is the same point as 1 so enter point number 1 and Pick OK to return to the 
previous dialog. 
 
It will now look like this: 
 

 

ntinue. 

w: 

 
Pick the OK button to co
 
Enter Closing Foresight Point 31, as shown belo
 

 
 
Pick the OK button to continue. 
 



 

You are asked for the actual coordina
lated values.  Enter in the following 

tes of point 31.  The numbers shown are 
the calcu KNOWN values, as shown: 
 

Pick the OK button to

 

 continue and the 
Traverse Closure Report will be generated 
on the Command Window.  
 
Then pick the EXIT button on the 
Assistant. 

 
 can also open this with a button on the MsMainControl 

Toolbar) and then scroll down using the slide bar on the right, until you see the 
is by going to the File pulldown menu on 

the Log Window and run the Print command.) 
 

Open the View Log (you

following.  (Remember you can print th
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Pick the X in the top right corner of the window to close it. 
    

Adjust Angles + Compass Balance 
 
We are now going to do an Angular Balance on this traverse.  Go to the 
MsTraverse drop-down menu -> Traverse Calculations and pick on the Angle 
Balance option. 
Answer YES to the following: 
 
Point Protection is currently ON. The Angle Balance program 
requires that we turn this OFF. Can the program turn OFF 
Point Protection? 
 
The angles on this traverse will be balanced. The closure will be recomputed and 
displayed. Pick on the ViewLOG button again and scroll down to the bottom to 
see the results shown here. 



 

 
 
Pick the X in the top right corner of the window to close it. 
 

raverse drop-

. The coordinates 

e bottom to see the 

 

Next you can perform a compass balance by going to the MsT
down menu -> Traverse Calculations and pick on the Compass Method 
Adjustment option. 
 

uleThe traverse will be balanced according to the Compass R
for the main traverse and any side shots will be adjusted. 
 
Now Pick on the ViewLOG button again and scroll down to th
results shown here. 
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 drop-down menu -
ntry/Editing and pick on the Show Traverse Graphically option. 

 

 
Pick the X in the top right corner of the window to close it. 
  
Now lets see the traverse on the screen. to the MsTraverse
> Traverse E

 
 
Answer NO if you wish to see the linework temporarily until a redraw command 
cleans up the screen.  Answer YES if you wish to draw every line into the 
drawing permanently  (with the toggles and labeling defaults controlling their 
appearance).  Entering Yes will produce this drawing: 
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Listing the Traverse

 
   

 
 
Finally, we will dump a listing of the traverse to the Log file.  Go to the 
MsTraverse drop-down menu -> Traverse Entry/Editing and pick on the List 
Traverse File option. 
There are two formats of the listing: long and short. 
 

 
 
Pick YES for the Short Listing. 
 
Now Pick on the ViewLOG button again and scroll down to the bottom to see the 
results shown here. 
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Keep scrolling to see the entire listing. 
 
(Remember you can print this by going to the File pulldown menu and picking on 
the Print command.) Pick the X in the top right corner of the window to close it. 
 
The new Active Drawing Technology Editor offers formatted listings of much 
higher quality than ever available before.  To start the ADT editor, run the Active 
Traverse Editor command found in the MsTraverse menu. Following is a print 
preview from the File menu of the Editor: 
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 (End of tutorial) 
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Property Line Tutorial 
 

Because of the size and complexity of this tutorial
smaller steps to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) COGO Calcs (Property Boundaries) 
 
Step 3) Distance/Distance Intersection 
 

 we have broken it down into 14 

oint Curve 
 
Step 5) More COGO 
 
Step 6) Bearing/Distance Intersection 
 
Step 7) And More COGO 
 
Step 8) COGO One More Time 
 
Step 9) More 3 Point Curves 
 
Step 10) Setting the Toggles 
 
Step 11) Locating the Buildings (Using OFFSETS) 
 
Step 12) Work on the SHED 
 
Step 13) Line Inverse 
 
Step 14) Job Complete 
 

Step 4) 3 P
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Starting the Job 
 
In this tutorial, we will be using COGO Only, to calculate a drawing of three 

a house and shed on the center property. During this 
cord our entry into the new Active Batch Cogo System.  The 

e field notes taken by a survey party to give you 

adjacent properties with 
tutorial, we will re
figure below illustrates some of th
a feeling for what you are entering.  
 

 
Property field notes 

 
To begin, start a new drawing by running the New… command, found under the 
File drop-down menu. 
 

Pick the New button in the Project Manager, and name the project 
COGO. Then pick Save to continue. 
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Set the M
General Co
Options to Me
Bearings with 

 

icroSurvey 
nfiguration 

tric, 
a scale 

factor of 1:250. This scale 
is chosen so the bearings 
and distances will be clear 
in MicroSurvey.  

 
 
Using the same procedure as the Traverse tutorial, set up the MicroSu
system toggles as shown. 
 

rvey 
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If the Assistant appears 
 

COGO Calcs (Property

on screen, pick the EXIT button to remove it. 

 Boundaries) 

alculations, turn on the Batch COGO 
MS_BATCH or select it from the MsCogo  Active 

.  The following dialog should appear 

 
 
Before we start performing COGO c
recording control by typing: 
Batch COGO   Load Control Dialog
 

 

choose New: 
 
Pick the Set button and 
 

 
 
You will be 
and press Save. 
 

prompted to enter a batch file name. Enter "Property Line Tutorial" 

Note: We have included 
this batch file for your use 
as a later comparison, or if 
you want cheat, you can 

 batch file and 
t do this if you 

just load the
run it. Do no
really want to learn how to 
use our COGO.

 
Now, Pick the Start button
 
To begin calculating the 
command prompt. Respond as sho
 

, and the dialog should show Recording ON. 

property boundaries, Type COGO at the MicroSurvey 
wn to these prompts: 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point <1>: 1  <Enter> 
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 in the file. Please enter it now. 

 
or the TAB key to move 

That coordinate is not

Fill out the dialog as shown (be sure to use the mouse 
between fields in the dialog) 
 

 
 
Pick the OK button to continue. 
 

y automatically asked you to define its 
location. 
 

.MMSS:<>:155.3030  <Enter> 

Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 30  <Enter> 
 
Enter the Solve Point: <2>: 2  <Enter> 
 
Enter Description:<>: BAR   <Enter> 
 

1   N55°30'30"E   30.000   1016.989   2024.726    2 
 
Pick the side you want the bearing placed/Above/Below: A  <Enter> 

Because point #1 did not exist, MicroSurve

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <1>  <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD
 



 

 
The bearing you just entered can be read as: First Quadra
degrees, Thirty min

nt (1), Fifty-five 
utes, Thirty seconds, or N 55° 30’30" E. 

 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <2> (At this point pick the Zoom 

 can see the info already 
ill appear on the command line) 

(Recording) Enter From Point: <2>  <Enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: 2..1-120   <Enter> 

Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
ce: <>: 32    <Enter> 

 

Enter Description:<BAR>: POST   <Enter> 

03.208   2053.607   3 

w: A <Enter> 

ld MicroSurvey to take 
t 1 and turn a counterclockwise angle of 120 

erse:Pt..Pt..Pt  
(
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: 2..3+90 <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 40    <Enter> 
 
Enter the Solve Point: <4>:  <Enter> 
 
Enter Description:<POST>: <Enter> 
 
3   S25°30'30"W   40.000   967.107   2036.381   4 

Extents button on the left side menu so we
entered) ('ZOOMFIT w
 

 

Enter the Distan

Enter the Solve Point: <3>:  <Enter> 

 
2   S64°29'30"E   32.000   10
 
Pick the side you want the bearing placed/Above/Belo
 
By replying to ENTER BEARIN
the bearing from point 2 to poin

G with "2..1-120", you to

degrees. Now let's continue… 
 
Inverse:Pt..Pt/Curve Inv
Recording) Enter From Point: <3> <Enter> 
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Pick the side you want the bearing placed/Above/Below: A <Enter> 

r>  (ZE is Zoom 

 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <4> ZE   <Ente
Extents)  
 

 look like this: At this point the screen should
 

 

4, we are going to jump back to point 1 and 

oint: <4>1   <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: 1..2+92  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 37.5   <Enter> 
 
Enter the Solve Point: <5>:  <Enter> 
 
Enter Description:<BAR>: <Enter> 
 

 
Rather than continuing from point 
started a new calculation: 
 
(Recording) Enter From P
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1   S32°29'30"E   37.500   968.370   2020.144   5 
 

ow: A <Enter> 

on

Pick the side you want the bearing placed/Above/Bel
   

Distance/Distance Intersecti  
 
Next is a DISTANCE - DISTANCE calculation so we can establish the center 
point of the curve at the front of the property. 

Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
 

olution (Y/N) (N for other 

4   S26°10'16"W   22.000   947.363   2026.678   6 
 
Enter Description:<BAR>: C <Enter> 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
6    N17°16'38"W   22.000   968.370   2020.144   5 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 

 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <5> 4   <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 22   <Enter> 
 
Enter the Solve Point: <6>:  <Enter> 
 

Enter Distance2: <>: 22   <Enter>
 
Enter the To Point: <5> <Enter> 
 

 East : 2026.678 Point :6 North : 947.363
 
Do you want to use this s
solution) Y  <Enter> 
 



 

Point :6 North : 947.363 East : 2026.678 

e:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
rom Point: <6>  ZE   <Enter> (ZE is Zoom 

Note that no special commands were required to do the DISTANCE - DISTANCE 
hen you replied to a bearing prompt 
 for all intersection calculations. Since 

sible solutions, you were offered the opportunity to 
works in a clockwise manner, so 

 
Invers
(Recording) Enter F
Extents)  
 

calculation; MicroSurvey knew to do this w
with the <enter> key. This logic is followed
this calculation yields two pos
use the "other" solution. Generally MicroSurvey 
the first solution offered is usually the clockwise solution. 
    

3 Point Curve 
Now we do a 3 point inverse to draw the curve and get the curve information: 

nverse:Pt..Pt..Pt  
 Point: <6>5..6..4   <Enter> 

 
Inverse:Pt..Pt/Curve I
(Recording) Enter From
 

 
 
Arc:    16.68  Chord:   16.29  Tangent:      8.77 
Delta: 43.2655  Radius:      22.00 
 
By entering three numbers as shown above, you told MicroSurvey to compute an 
angle clockwise from point 5 to point 4 with point 6 as the center of curvature. 
 

You should see this now: 
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More COGO

 
 

 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <6> 1   <Enter> 

Options: +/- or Pt..Pt+-Angle 
:<>: 2..1   <Enter> 

) a Distance 

 
Enter the Solve Point: <7>:13   <Enter> 
Enter Description:<C>: (space) <Enter> 
 
1   S55°30'30"W   30.000   983.011   1975.274   13 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
Entering the distance as "2..1" tells MicroSurvey to use the distance from point 2 
to point 1, or 30 meters in this case. 

 

Enter Quadrant Bearing like QDD.MMSS
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/
Enter the Distance: <>: 2..1 <Enter> 
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Bearing/Distance Intersection 
 

Next we want to do a BEARING - DISTANCE calculation from point 13 and point 
6. Again, we will get two possible solutions and this time the "other" soluti
be the one we want. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <13> ZE  <Enter> (ZE is Zoom 
Extents) 
 

g should look like this: 

on will 

At this point your drawinAt this point your drawin
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Bearing/Distance Intersection 
 

Next we want to do a BEARING - DISTANCE calculation from point 13 and point 
6. Again, we will get two possible solutions and this time the "other" solution will 
be the one we want. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <13> ZE  <Enter> (ZE is Zoom 
Extents) 
 

g should look like this: 

 
 
(Recording) Enter From Point: <13>  <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: 13..1+70   <Enter> 
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Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*
Enter the 

/) a Distance 
Distance: <>: <Enter> 

ngle 
Enter Quadrant Bearing #2 like QDD.MMSS: <>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>: 22   <Enter> 
 

 

7.363   2026.678   6 

earing placed/Above/Below: A <Enter> 

 
Enter the Solve Point: <14>:  <Enter> 
 
Options: +/- or Pt..Pt+-A

Enter the To Point: <14>  6   <Enter> 
 
Point :14 North : 933.912 East : 2044.087 
Do you want to use this solution (Y/N) (N for other solution) N   <Enter> 
 
Point :14 North : 959.450 East : 2008.296 
Do you want to use this solution (Y/N) (N for other solution) Y  <Enter>
 
13   N56°40'24"W   22.000   959.450   2008.296   14 
 
Enter Description:< >: POST   <Enter> 
 
Pick the side you want the bearing placed/Above/Below: A <Enter> 
 
14   S56°40'24"E   22.000   94
 
Pick the side you want the b
 

 
Do a redraw to ensure the screen looks clean by 
picking the button at the top left of the screen. 

   

And More COGO 
 
Now we calculate point 19: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <14>  3   <Enter> 
 



 

Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: 2..3  <Enter> 

/tan... or Pt..Pt(+-*/) a Distance 

 (space) <Enter> 

5.728   19 

w: A <Enter> 

e used the spacebar to 
: 

t  
er> 

Enter Quadra  229.2930   <Enter> 
 

s: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
istance: <>: 1..2   <Enter> 

 
 Point: <7>: 20  <Enter> 

nter> 
 
19   S29°29'30"E   30.000   976.083   2070.497   20 
 
Pick the side he bearing placed/Above/Below: A <Enter> 
 
Now we will calculate Point 21 using a Distance-Distance Intersection. Take the 
second distance from the points on the drawing by entering a two point inverse: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <20> <Enter> 
 
Options: +/- or Pt..Pt+-Angle 

 
Options: C#=-*/sin/cos
Enter the Distance: <>: 2.35   <Enter> 
 

 <7>:19 <Enter> Enter the Solve Point:
 
Enter Description:<POST>:
 
3   S64°29'30"E   2.350   1002.196   205
 
Pick the side you want the bearing placed/Above/Belo
 
Since we did not want any description for this point, w
blank the default that was offered. Now we calculate Point 20
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..P
(Recording) Enter From Point: <19> <Ent
 
Options: +/- or Pt..Pt+-Angle 

nt Bearing like QDD.MMSS:<>:

Option
Enter the D

Enter the Solve
 
Enter Description:<BAR>: (space) <E

 you want t
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Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 

n... or Pt..Pt(+-*/) a Distance 
.2   <Enter> 

:  <Enter> 

Pt(+-*/) a Distance 

 : 2048.307 
  Y <Enter> 

8.307   21 

Pick the side you want the bearing placed/Above/Below: A <Enter> 

 947.363   2026.678   6 
he bearing placed/Above/Below: A <Enter> 

.307 

 
Options: C#=-*/sin/cos/ta
Enter the Distance: <>: 33
 
Enter the Solve Point: <21>
 
Options: C#=-*/sin/cos/tan... or Pt..
Enter Distance2: <>:  4..6   <Enter> 
 
Enter the To Point: <21>   6  <Enter> 
 
Point :21 North : 951.388 East
Do you want to use this solution (Y/N) (N for other solution)
 
20   S41°56'32"W   33.200   951.388   204
 

R   <Enter> Enter Description:< >: BA

 
21   S79°27'21"W   22.000  
Pick the side you want t
 
Point :21 North : 951.388 East : 2048
  

More 3 Point Curves 
 

heNext we do a 3 point inverse to draw t
the curve information: 

 curve between points 4 and 21 and get 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <21>  4..6..21   <Enter> 
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Arc:     20.46  Chord: 19.73  Tangent:  11.04 

 22.00 

And the last curve can be calculated between points 14 and 5. 

t  
1> 14..6..5 <Enter> 

Delta: 53.1705  Radius:   
 

 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..P
(Recording) Enter From Point: <2
 

 
 
Arc:     15.13  Chord:   14.83  Tangent:    7.88 
Delta: 39.2345  Radius:  22.00 
 

Setting the Toggles 
 
At this point your job should look like this: 
 



 

 

les dialog to change the toggles so that 
and distances on the sides of the house and 

Click on the Draw Bearings toggle. 
Click on the Draw Distances toggle. 
 

The Hot 
Toggles dialog 
should now 
look like this: 

 
Now we will use the Hot Togg
MicroSurvey will not draw bearings 
shed. 
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Locating the Buildings (Using OFFSETS) 

Now we will locate the house and shed on the center property. The figure below 
 structures in expanded detail as defined by the field notes. 

 

shows these
 

 
 
We begin locating the structures wit  a BEARING - BEARING intersection with 
OFFSETS. The bearings are taken f om the lines by doing two point inverses. 
The offset distances are n. Long ago one of our 
customers said they always write their field notes with o/s to signify offsets so 
they recommend we use the % sign
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <21> 5   <Enter> 
 

h
r

entered by using a % sig

. It works… 
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Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>  5..1%: 8.5  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: <Enter> 

 

:5..4%-16.49 <enter> 

 

earings tells MicroSurvey that you are 
 right and negative is to the left 

h an OFFSET. 

 

 
.MMSS:<>:  5..1%9.1 <Enter> 

Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:  <Enter> 
 
Enter the Solve Point: <8>:  <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing #2 like QDD. SS: <>: <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>: 3   <Enter> 
 

 
Enter the Solve Point: <7>:  <Enter>
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing #2 like QDD.MMSS:<>
 
Enter the To Point: <6>  5 <Enter> 
 
Enter Description:<C>  (space) <Enter>
 
5  N01°39'31"W    16.584    984.947    2019.664    7 
7  S01°39'31"E    16.584    968.370    2020.144    5 
 
To review: the % sign used in the b
entering information on an offset. Positive is to the
of the reference line.  
 
Next is a BEARING - DISTANCE intersection wit
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <7>  5  <Enter>
 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like QDD
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Enter the To Point: <6>  7   <Enter> 
 
Point :8 North : 987.749 East : 2018.591 

/N) (N for other solution)  Y <Enter> 

591    8 

(space)  <Enter> 

019.664    7 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  

  8..7-90   <Enter> 

 Pt..Pt(+-*/) a Distance 
: 2   <Enter> 

 

  988.464    2020.459    9 

t  
<Enter> 

+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>:  9..8+90   <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 5   <Enter> 
 
Enter the Solve Point: <10>: <Enter> 
 
Enter Description:< >: <Enter> 
 
9  N20°57'17"W    5.000    993.133    2018.671    10 
 

 
Do you want to use this solution (Y
 
5   N20°57'17"W    3.000    987.749    2018.
 
Enter Description:<C>: 
 
8   S20°57'17"E    3.000    984.947    2
 

(Recording) Enter From Point: <8> <Enter> 
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>:
 
Options: C#=-*/sin/cos/tan... or
Enter the Distance: <>
 

   <Enter>Enter the Solve Point: <9>:
  <Enter> Enter Description:< >:

 
8   N69°02'43"E    2.000  
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..P
(Recording) Enter From Point: <9> 
 
Options: +/- or Pt..Pt
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Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <10> <Enter> 

Enter Quadrant Bearing like QDD.MMSS:<>:  10..9-90   <Enter> 

(+-*/) a Distance 

 

.142   11 

rse:Pt..Pt..Pt  
m Point: <11> <Enter> 

 
DD.MMSS:<>: <Enter> 

+-*/) a Distance 

<12>: <Enter> 

os/tan... or Pt..Pt(+-*/) a Distance 
  10.2   <Enter> 

 
Point :12 North : 988.504 East : 2029.224 
 
Do you want to use this solution (Y/N) (N for other solution) Y <Enter> 
 
11   S22°21'59"E   8.100   988.504   2029.224   12 
 
Enter Description:< >: <Enter> 
 
12   S69°35'36"W   10.200   984.947   2019.664   7 
 

 
Options: +/- or Pt..Pt+-Angle 

 
Options: C#=-*/sin/cos/tan... or Pt..Pt
Enter the Distance: <>: 8   <Enter> 
 
Enter the Solve Point: <11>: <Enter>
 
Enter Description:< >: <Enter> 
 

0   995.994   202610   N69°02'43"E   8.00
 
Inverse:Pt..Pt/Curve 
(Recording) Enter Fro

Inve

 
Options: +/- or Pt..Pt+-Angle
Enter Quadrant Bearing like Q
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(
Enter the Distance: <>: 8.1   <Enter> 
 
Enter the Solve Point: 
 
Options: C#=-*/sin/c
Enter Distance2: <>:
 
Enter the To Point: <12>  7   <Enter> 
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Point :12 North : 988.504 East : 2029.224 

Work on the SHED 
 
This completes the house; now we proceed to the shed. For the following 

tion, we will select the "other", or NEAR solution. 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
 Point: <12> 11   <Enter> 

MMSS:<>: <Enter> 

/tan... or Pt..Pt(+-*/) a Distance 

... or Pt..Pt(+-*/) a Distance 

2   <Enter> 

 2023.372 

lution)  N  <Enter> 

.881 East : 2028.410 

olution)  Y <Enter> 

11   N30°16'10"E   4.500   999.881   2028.410   15 
 
Enter Description:< >: <Enter> 
 
15   N12°09'07"W   17.500   1016.989   2024.726   2 
 
Point :15 North : 999.881 East : 2028.410 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <15>  2   <Enter> 

DISTANCE - DISTANCE calcula
 

(Recording) Enter From
 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.
 
Options: C#=-*/sin/cos
Enter the Distance: <>: 4.5   <Enter> 
 

5>:  <Enter> Enter the Solve Point: <1
 
Options: C#=-*/sin/cos/tan
Enter Distance2: <>:  17.5   <Enter> 
 
Enter the To Point: <12>  
 
Point :15 North : 999.541 East :
 
Do you want to use this solution (Y/N) (N for other so
 
Point :15 North : 999
 
Do you want to use this solution (Y/N) (N for other s
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Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: <Enter> 
 

 Pt..Pt(+-*/) a Distance 
 

r> 

-*/) a Distance 
   

49 East : 2030.033 

 for other solution)  Y <Enter> 

 

2028.410   15 

01.049 East : 2030.033 

<16>  <Enter> 

Enter Quadrant Bearing like QDD.MMSS:<>: 16..15-90  <Enter> 
 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>: 2.5  <Enter> 
 
Enter the Solve Point: <17> :  <Enter> 
 
Enter Description:< >: <Enter> 
 
16  S35°44'20"E   2.500    999.020    2031.494    17 
 

Options: C#=-*/sin/cos/tan... or
Enter the Distance: <>: 16.8   <Enter>
 
Enter the Solve Point: <16>:   <Ente
 

an... or Pt..Pt(+Options: C#=-*/sin/cos/t
Enter Distance2: <>: 2   <Enter>
 
Enter the To Point: <3>  15   <Enter> 
 
Point :16 North : 1001.0
 
Do you want to use this solution (Y/N) (N
 
2   S18°24'55"E   16.800   1001.049   2030.033   16 
 
Enter Description:<POST>: (space) <Enter>
 
16   S54°15'40"W   2.000   999.881   
 
Point :16 North : 10
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: 
 
Options: +/- or Pt..Pt+-Angle 



 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
 <Enter> 

gle 
 QDD.MMSS:<>: 17..16-90  <Enter> 

/) a Distance 
nce: <>: 15..16   <Enter> 

nter> 

rawing, but at this point your 

(Recording) Enter From Point: <17>
 
Options: +/- or Pt..Pt+-An
Enter Quadrant Bearing like
 

/tan... or Pt..Pt(+-*Options: C#=-*/sin/cos
Enter the Dista
 
Enter the Solve Point: <18> :  <E
 
Enter Description:< >:   <Enter> 
 
17   S54°15'40"W   2.000   997.851   2029.870   18 
 
We need to erase a few extra lines that are on the d
drawing should look like this: 
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Line Inverse 

Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
(Recording) Enter From Point: <18>  15..18   <Enter> 

 

 
You should see this 
information dialog. Press 
the Ok button: 

15   S35°44'20"E   2.500   997.851   2029.870   18 
 

 
rse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  

(Recording) Enter From Point: <18> Esc 
 

Job Complete

Inve

 
 
The shed is now complete. Finally, by deleting unneeded lines, we get the 
property drawing shown below.  
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Final property drawing 

 
Save your job by picking the SAVE command from the File pulldown menu. 
 
Now, Pick the Stop button on the Batch COGO Control window. It should show 
Recording OFF. 
 
Pick the Edit button and you should see something like this window.  It has been 
expanded so you can see more: 
 



 

 
 
Pick the SP and you can edit the starting coordinates. 
 

 

Pick the Edit menu and you can see all the commands available for building a 
batch file: 
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change to a pull Scroll to the Bottom of the Grid and Pick the Type Cell  it will 
down combo box with all the record types listed: 
 

 
 
 
(End of tutorial) 
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Earthwork Volume Tutorial 

he size and 
s to make it 

Step 1) Starting the Job 

Step 2) Setting the Defaults and Tog

orting a Data Collector 

Step 4) Creating the Traverse File 

Step 5) Processing and Editing the 

 
Because of t complexity of this tutorial we have broken it down into 14 
smaller step easier for you to follow. 
 

 
gles 

 
Step 3) Imp File 
 

 
Traverse File 

 

Step 7) Working with AutoMAP 
 
Step 8)  Start the First Surface 
 
Step 9) Make the First TIN 
 
Step 10) Start the Second Surface 
 
Step 11) Ext
 
Step 12) Ma

Step 13) Calculate Volumes between the 2 Surfaces 
 
Step 14) Cross Sections across the Job 
 

Step 6) Coordinate the Traverse 
 

ract the Second Surface 

ke the Second TIN 
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Starting the Job 
To begin, start a new drawing by running the New… comma
File drop-down menu. 

nd, found under the 

Manager.  Fill in the name of the job and call 
e to continue. 

nd Toggles

 
Pick the New button on the Project 
it VOLUMES. Then pick Sav

 

Setting the Defaults a  

 asked to check or set the General Defaults. 
 
As soon as the job is open you are
 

 
 
Please take the time to make your General Defaults the same as shown here.  
Pick the OK button to continue. 
 
Now that your job is open, you have many options presented to you.  The first set 
of options are available from the MicroSurvey Assistant – Main Menu.  This is 
a floating dialog box with commands on it that you can pick. 
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We will go a ram defaults.  To do this pick the button 
Set Progra will be given another dialog box to choose 
from. 
 

nd check and set the prog
m Defaults.  Next you 

 
 
In this dialog box we can choose to set any of the drawing defaults that we may 
need.  In this tutorial we are going to assume that everything we do not look at is 
considered okay for this job. 
 
We need to check our Toggles so pick the COGO Toggles button.  This will 
show you the following dialog boxes.  Please make yours look the same as ours 
shown here.  When done pick the OK button. 
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Sy
 
Pick the n to the 
MicroSu .  Press the OK button to return to the 
MicroSu
 

stem Toggles dialog boxes 

OK button to continue.  This will take you back agai
rvey Assistant – Defaults Menu
rvey Assistant – Main Menu. 

 

Importing a Data Collector File 

From here we are going to go through the step
from the hard drive into our program and save it into a traverse file. 

 
s to read our data collector file 

 
Pick on the button labeled Import ASCII File or Data Collector File.  You will 
see this nex
 

t dialog box. 
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We are going to import a data collector raw file so pick the button labeled Import 
Data Collector ASCII File.  This will bring up a dialog box with all the different 
collector types that we support. 
 

 
 
As you can see, the list of supported collector files is very large and includes all 
the major brands on the market.  For this tutorial we will use a file collected in the 
Topcon format.  (This is not saying that Topcon is the collector of choice, only 
that the file used in this tutorial was of this format.  All of the other collector 
formats would give equally suitable data in this type of job.) 
 
Pick the button labeled Topcon FC4/On Board (bottom left corner of the 
dialog).  As soon as you do you will be presented with the following dialog box; 
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This allows you to quickly check or change your toggles before proceeding.  Pick 
the OK button to continue. 
 
You will then be asked to give the file name of the collector file. Go to the 
\MSCAD 20  the file Fc4-big2.raw. 
 

05\TUTORIAL directory and pick on

 
 
Once you have selected the correct file, press the OPEN button to continue. 
 

 

Creating the Traverse File 
 
You will then be presented with the dialog box asking if this is a New or Existing 
Traverse. 
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This is a New Traverse so pick the New Traverse but
to name your traverse file.  This allows you to have 

ton.  Now you will be asked 
several traverses in one job 

and keep them all organized so you can work on them separately. 
 

 
 
You can name your traverse file anything that makes sense to you.  I have 
chosen the name VOLUMES for the traverse. The program will use the project 
name as the default. Once you have entered the name press the Save button. 
 
Next you will be asked to enter some information about this traverse.  You may 
leave this blank if you wish but a good practice is to fill in the information as it is 
used later in printouts. 
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Then press the OK button to continue. 
 
From this point, the program very quickly reads the raw data file from the hard 
drive and stores it into our traverse file.  You will see the information scrolling 
very quickly at the top of the screen in the prompt area.  You should see 4  points 

as coordinates in the raw 
collector f w data and have not 
on the main screen. These were points entered 

ile.  The rest of the shots have been recorded as ra
been coordinated. We will do that next... 

 

Processing and Editing the Traverse File 
 

You will see this dialog box in the middle of the scre
 

en. 

 
 
Pick on YES so we can see the raw data in the traverse file and confirm 
that it is correct and complete. If the Assistant is still open, close it down 
so you can work on the traverse file.  You should see the following 
window with the raw data from the survey. 
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Coordinate the Traverse 
 

Select Re-coordinate Traverse fro
Editor.  Or you can ty
 
You will be 

m the Edit Menu on the Active Drawing 
pe Ctrl-R if the editor window is current. 

given the option of creating a Recoordination Report or Log. Accept 
the defaults as shown: 
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Now you 
the screen as

 

will see the coordinates being calculated in the prompt area on top of 
 well as the information being drawn into the graphics window.  The 

entire job will be imported and displayed on screen. 

 
 

s soon as you do a 
nothing but the 

points at tha a zoom or redraw command we have to exit 
he OK button and then the EXIT 

The linework you see is only temporary and will be erased a
zoom command or a redraw command.  You will be left with 

t time.  To be able to do 
out of the MicroSurvey Assistant menus.  Press t
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button to get out of the assistant.  Then do a Zoom Fit (zoo
this button on the left of the screen.  

m extents) by picking 

 
 
You will now see the points as shown below. 
 

 
 

Working with AutoMAP 
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Our objective is to calculate the volume of this pile of earth.  To do this we need 
to layer separate the data to help us build the two surfaces.  In other words we 

s of TOP to be on one layer and the points 
with descriptions of BOTTOM on a different layer.  This will make it easier to 
select the correct points to create surfaces to generate volumes. 
 
To do this w can find this in the 
MsTraverse  available in other 
locations as 
 
This will d
 

want all the points with description

e are going to use the AutoMap program.  You 
 pulldown | Automap System. This command is
well. 

isplay the dialog box below. 

 
 

ommand but we will just use a portion of it’s power in this 
tutorial.  First thing you need to do is pick the New Library button.  This will 
remove the current listing of descriptions (which do not match our current job) 
and allow us to then pick the Scan Dbase button which will go to our job and 
look up every description we used and display them, ready for editing. 
 

This is a powerful c
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scriptions.  BOTTOM, TOP and NL
only defined the control points and is not related

 so we are going to delete this description from our list.  
ints for the job.  It only means that the points wil

 
This job has 3 different de .  We do not need 
the NL description as it  to the 
surfaces we are creating,
This will not erase the po l not be 

hem, so do not worry.  
nd then pick the Delete 

You will be asked if you are sure that you wish to delete this description. 
 

relocated to another layer or have linework connecting t
Pick the description NL from the left side of the dialog a
button. 
 

 
 
Pick the YES button to continue. 
 
This will leave you with only the BOTTOM and TOP descriptions to be edited.  
Now pick on the description BOTTOM and pick the Edit button.  You will now see 
this dialog box. 
 



 

 
 
This dialog box has many options on it.  The ones we are concerned with are in 
the bottom half.  Set your program to match the dialog below. We are not 

g all the 
 point number order.  We are 

 same layer as the 

applying any symbols, but we are going to draw a 3D polyline connectin
points with the description Bottom, in increasing
also moving the nodes, elevations and point numbers to the
description and polyline. Note: Set the layer color to Red. 
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When you have set all the options as above then press the OK button and edit 
the description TOP in the same method.  The settings are shown below. Note: 
Set the layer color to Blue. 
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Pick the OK button after setting the above dialog. 
 
Lets save this library for future use.  Pick on the Save Library button. 
 

 
 
Give the library a unique name of VOLUMES, as shown above.  Pick the SAVE 
button to continue. 
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Now all that is left is to process the settings for the descriptions.  Press the 
  Process AutoMAP Connections Now button. 

 
Now you will see the following dialog box; 
 

  
 

ding option i
inue. 

Using the Explorer we will freeze the layers shown below by picking on the layer 
names to highlight them. Pick the “Thawed” word as shown below to toggle 
the value to “Frozen” to freeze the layers – lastly, exit the Explorer. 
 

Because we are not using the Z-Co
the Skip XYZ Method button to cont

n this example, simply pick on 

 

 
 
Now your job should look like this. 
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The Bottom points have all been placed on the BOTTOM la
a 3D Polyline and the Top points have all been placed on th
connected separately by another 3D Polyline.   
 

 

Start the First Surface

yer and connected by 
e TOP layer and 

 
Now we are ready to generate 2 surfaces to ca
The first surface will have all of the T
upper surface of the pile.   

 
To do this we will load the palette from the MsModeling pulld
picking on the option Modeling Palette….  The following pa
appear on screen.  Move it to a convenient loca
 

lculate volumes from.  
op and Bottom points to define the 

own menu by 
lette (toolbox) will 

tion on the right of the screen. 

 
 



 

To extract points to a surface, pick this button.  

  Please fill it out as shown below and then 
 
The following dialog box will appear.
pick the OK button to continue.  
 

 
 
After picking the OK button you will be asked to select all 
this surface.  We need all of the poin
simply press the ENTER button to select them all

the points to be used in 
ts on screen to form the top surface so 

 
27 points total in surface. 

We have now defined the surface by extracting the points, but we now also need 
th curately reflect the 
surface edg

utton. 

. 
 
It should report in the command prompt area; 

7
 

e breaklines to add more detail and make the surface ac
es of the pile. 

To extract the breaklines to the same surface, pick this b  
hown below and then 

pick the OK button to continue.  Note: remove the Clear before extract 
The following dialog box will appear.  Please fill it out as s

checkbox!
 

 
 

used in this surface.  We need all of the linework on screen 
surface so simply press the ENTER button
something like this on the text screen: 

After picking the OK button you will be asked to select all the breaklines to be 
to help form the top 

 to grab them all. You should see 
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2 Break Lines extracted 
337 stacked points dropped, 
Auto densification... 
756 triangles built 
1206 triangles built 
1308 triangles built 
1348 triangles built 
1372 triangles built 
1386 triangles built 
1398 triangles built 
321 additional points added to current surface 
 

 

Make the First TIN 

Next we need to create a TIN for this surface. Pick this button.  from the 

wer them as follows; 

Surface name <TOP>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been 
generated correctly.   

palette. 
 
The TIN command will ask you several questions.  Ans
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A redraw or zoom command will remove the TIN from the screen. 
 

 

Start the Second Surface 
 
Now we need to create the Bottom surface.  It is difficult to pick the points around 
the outside edge of the pile without accidentally picking other points as well, so 
we will isolate the bottom layer on screen.  This command can be found on the 
MsTools  Layer Control Tools then pick the ISOLATE option. 
 
After the command load you will be asked to: 

Select item on layer to isolate: Pick on one of the red lines, then 
press <ENTER> 
 
Now the job should look like this: 
 



 

 
 

Extract the Second Surface 

To extract the points to a new surface, pick this button.  

g dialog box will appear.  Please fill it out as shown below and then 
ntinue.  

 

 
The followin
pick the OK button to co

 
 
After picking the OK button you will be asked to select all the points to be used in 
this surface.  We need all of the points on screen to form the bottom surface so 
simply press the ENTER button to grab them all. 
 
It should report in the command prompt area; 
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117 points total in surface. 
 
So far we have the points that help 
breaklines. 

To extract the breaklines to the same surface, 

define the surface but we now also need the 

pick this button.  
  Please fill it out as shown below and then 

NOTE: Remove the Clear before extract 
The following dialog box will appear.
pick the OK button to continue.  
check box.
 

 
 
After picking the OK button you will be asked to select all 
used in this surface.  We need all of the linework on scree

the breaklines to be 
n to help form the 

bottom surface so simply press the ENTER button to select them all. 
 

Make the Second TIN 
 

 
 
The TIN command will ask you several questions.  Answer them as foll

Next we need to create a TIN for this second surface. 
Pick this button. from the palette. 

ows; 
 <Enter> 

 <Enter> 

lay the TIN so we can confirm that the TIN has been 

Surface name <BOTTOM>:
 
None/Show/Draw/Redraw <Show>?
 
This will temporarily disp
generated correctly.   
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A redraw or zoom command will remove the TIN from the screen. 

 

Calculate Volumes between the 2 Surfaces 
 
Now we can late the volume between the surfaces called TOP and 
BOTTOM. 
 
We can calculate the volume in two different ways.  First we will run the Surface 
Volume command from the MsModeling pulldown menu  Volumetrics. 
 
Fill out the two surface names as shown with the TOP surface on the left and the 
BOTTOM surface on the right.  Be sure to pick the check box beside Surface 
Name to be able to enter the BOTTOM surface 
 

 finally calcu
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lculated and displayed in the 
.  Flip to the command prompt window by 

normal screen) 

olume will be displayed like this. 

                         

Positive Volume         Negative Volume              Net Volume 
---------------         ---------------              ---------- 
                     46522.834             -3.449e-005               
46522.834 

 
The negative volume shown here is so small that it does not affect the job in any 
way and was due to minor deviations in the way the two TINs were generated.  
Your final volume is  46,522.834 m3 (because our job was in metric – if it had 
been feet then the units would have been cubic feet by default) 
 
The Second way to calculate the volumes between the same two surfaces is the 
Area Volume command.   
 

 
Now pick the OK button and volumes will be ca
command prompt area on screen
pressing the F2 function key (a second time to return to the 
 
The v
 
Using conversion factor of 1.            
 
Volume of TOP-BOTTOM based on a planar tin. 
 

 
Run the Area Volume command by picking this 
button  from the palette. 
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Fill out the 

prompted… 
 

 
(NOTE: olyline 

toMAP command due to 
ay find that you have to 

round the 

The volume  
ans
 

                          

       Net Volume 
       ---------- 

         46522.834             -3.449e-005       46522.834 
 
Area 1 ill a e drawing. 

 

Cross Sections across the Job

surfaces in exactly the same way as we did above for the Surface 
Volume command.  Pick OK to continue.   
Now for the slight difference between the two methods.  You are now 

Select area polygons: 
Return to select all visible or 
Select objects: Pick the RED polyline around the bottom of the pile 
and press <enter> 

 When doing one of your real jobs instead of this tutorial – the p
around the base may not be created properly with the Au
the order the points were picked up in, in the field.  You m
manually draw a polyline from point to point instead.) 
 
The polyline you pick now is the one that we drew with AutoMAP, a
base of the pile. 
 

report will be the same – confirming that we have the correct
wer. 

Using conversion factor of 1.                
 
Volume of TOP-BOTTOM based on a planar tin. 
 

Area           Positive Volume         Negative Volume
----           ---------------         ---------------
            

w lso be labeled on th

 
 
For those who wish to confirm the volume by seeing cross sections to prove the 
answer, we have just the feature to do this. 
 
Under the MsDesign pulldown menu AutoRoute options there is a command 
Across Full Surface. 
 
You will be  surface you wish to plot.  Select TOP and press OK. 
 

asked which
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nter line for all the 
the Interval for the 

h/East/<West>: N  
<Enter> 

: 20 

s will be drawn over the job as 

Next you will be asked which way do you wish to run the ce
cross sections to be related to.   Then you will be asked for 
cross sections. 
 
Begin on which side of surface North/Sout

 
Enter cross section interval
 

A center line and cross section line
reference. 
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If you wish, you can erase these lines, or leave them for later reference.  Your 
choice!  
 

 
 
I left them on in my example by answering NO. 
 
Next you will be asked if you wish to plot the cross sections.  
  



 

 

Answer Yes to this and 
following dial
on the cross sections

 

you will get the 
og box that controls the grid 

. 

 

Fill your dial

height of the
mm. If 
feet, you wo
inch size of t
were using, 

 

og box out as 
shown above and when 
completed press the OK 
button.  Note: This job is a 
Metric job, so the width and 

 sheet are in 
you were working in 

uld put in the 
he paper you 
like 24 x 36 

 
Pick lower left corner:  This is the insertion point for the cross sections 
so select a starting point over to the right of the diagram so they do not overlap 
each other. 
 

 enlarged.   

. When you pick the Ok button, You will be prompted with: 

Below is one of the cross sections
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etter visual results or for setting 
pen widths fo

ross sections, to 
work out the volume the old hand method. 

Save your job by picking the SAVE command from the File pulldown menu.  
Then be sure to save your surfaces, as you were shown in the Data Collector 
Tutorial. 
 
(End of tutorial) 

 

You can change the color of the layers to get b
r plotting.   

As a double check you can calculate the volume under the c
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Road Design Tutorial 
 
Because of the size and complexity of this tutorial we have broken it dow
smaller steps to make it easier for you to follow. 
 
Step 1)  Opening the Job 
 
Step 2)  Create the Ground Surface 
 

n into 9 

reate Cross Section Template 
 
Step 8) Create New Road Surface 
 
Step 9)  Output Cross Sections 
 

Opening the Job

Step 3)  Inputting the Horizontal Alignment 
 
Step 4) Stationing and Saving the Horizontal Alignment 
 
Step 5)  Create Profile 
 
Step 6)  Design New Profile 
 
Step 7) C

 
 
Start by opening the CONTOURS.DWG file using the Open command found in 
the File menu. The CONTOURS.DWG file should reside in your \MSCAD 
2005\TUTORIAL directory by default.  You will need to change the Project 
Manager -> Project Directory to point to the Tutorial directory, or you can copy 
the CONTOURS.DWG file to the \JOBS2005 directory and open it there. 
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Pick on the job name and then pick the Open button. 
 
The system General Configuration Options should be set to match the following 
for this job to work cleanly.  Press the OK button once they are confirmed to be 
correctly set. 
 



 

 
 
 
Exit out of the MicroSurvey Assistant if it comes up on s
need this excellent tool for this tutorial. 
 

creen.  We will not 

You will see a series of contours and a few points, they will be used to define 
your existing surface. 
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Create the Ground Surface 

EAS command to create 
 
Do the SAV
starting point.  This will protect the ori
again if you wish. 
 
Type SAVEAS and press enter
the SAVE AS… command.. 
 

a new drawing using the contours as a 
ginal data so you can execute the tutorial 

, or go to the File drop-down menu and pick on 

 

Change the default folder to save in \JOBS2005 and change the file name to 
DWG  then pick the SAVE button to continue. 

ed to extract all of the 3D point data and 3D breaklines (con
xisting surface. 
e are going to control what is on screen by isolating the point
es on screen, one at a time.  Under the MsTools pulldown 

r Control pick the ISOLATE option. 
Select item on layer to isolate: (pick on one of the points and press Enter)

will see on screen are the points. 

will load the Modeling palette from the MsModeling pulldown 
 the option Load Modeling Toolbox.  The following palette (t

 

CONT.
 
Next, we ne tours) to 
create the e
To do this w s and 
the breaklin menu -> 
Laye

 
Now all you 
 
Next we menu by 
picking on oolbox) 
will appear on screen.  Move it to a convenient location on the right of the screen. 
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rface, pick this button. 

 

To extract points to a su  
 
The following dialog box will appear.  Please fill it out as shown below and then 
pick the OK button to continue.  
 

 

the points to be used in 
ts on screen to form the top surface so 

 
After picking the OK button you will be asked to select all 
this surface.  We need all of the poin

 we now also need the 

on the UNISOLATE 
option, this brings back the breakline layer.  Now Under the MsTools pulldown 
menu -> Layer Control pick the ISOLATE option.   
 
Select item on layer to isolate: (pick on one of the breaklines (contours) and 
press Enter) Now all you will see on screen are the breaklines (contours). 
 

To extract the breaklines to the same surface, pick this button. 

simply press the ENTER
 

 button to grab them all. 

It should report in the command prompt area; 
21 points total in surface. 

So far we have the points that help define the surface but
breaklines. 
 
Under the MsTools pulldown menu -> Layer Control pick 

 
The following dialog box will appear.  Please fill it out as shown below and then 
pick the OK button to continue.  
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After picking the OK button you will be asked to select all the breaklines to be 
used in this surface.  We need all of the linework on screen to help form the top 
surface so ab them all. 
 

Next we nee Pick this button. 

simply press the ENTER button to gr

d to create a TIN for this surface.  from the 
palette. 

er them as follows; 

ter> 

 
e TIN has been 

 
The TIN command will ask you several questions.  Answ
 
Surface name <GROUND>: <En
 
None/Show/Draw/Redraw <Show>? <Enter> 

This will temporarily display the TIN so we can confirm that th
generated correctly.   

 
 
A redraw or zoom command will remove the TIN from the screen.  The Tin will 
remain in memory. 



 

 

Inputting the Horizontal Alignment 

n create our alignment. 

oute and picking the 

 
llowing, please enter 

the information shown: 

 MAPLE 

use only a single word, with no 

ge_Side_Road, Maple_Street, Pine-Street, Maple 
 
From point: -200,100 
To point: 1,90 
To point: 70,-45 
To point: 240,-50 

an alignment. You 

 
Now that we have our surface we ca
 
Start by going to the MsDesign pulldown menu -> AutoR
Design Alignment command. 

In the Command prompt area, it will ask you the fo

 
Enter alignment name:
 
* NOTE * 
When naming a horizontal alignment, be sure to 
spaces, as the name, such as: 
ROAD1, Oran

To point:  <Enter> 
 
Note: It is not necessary to enter exact coordinate to create 
can also "pick" the points on screen. 
 
The center line of the road is now drawn. 
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l be asked if you wish to edit the alignment: 
 
Next you wil
 

 

Answer Yes so we can insert new curves and spirals. 
 
Edit alignment. Add/Delete/Move/Curve/SCS:  SCS 
 
Pick POT:   <pick the red circle at the FIRST bend in the road> (zoom in if 
you can not pick it easily.  Don’t miss it!) 
 
Now you will see the following dialog box. 

 



 

 
 

s shown above, and then pick the 
e the rest of the fields in the dialog 
nd curve on the screen. 

Edit alignment. Add/Delete/Move/Curve/SCS: Curve 
 
Pick POT: <pick the red circle at the SECOND bend in the road> (zoom in if 
you can not pick it easily.  Don’t miss it!) 
 
Enter curve radius: 50 
 
Pick POT:   <Enter> 
 
Edit alignment. Add/Delete/Move/Editcurve/Newcurve:  <Enter> 
 
Now you will be asked if you wish to continue and profile the existing ground 
surface? 
 

Fill in the top left corner of the dialog, a
Calculate Spiral Variables button to calculat
box.  Pick the OK button to place the spirals a
 
Pick POT: <Enter> 
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 for now. 

your job should look like this: 

 
Pick NO
 
At this point 
 

 

 

Stationing and Saving the Horizontal Alignment 

 

 
 
Before we continue with the profile lets label the stationing along the alignment. 
Go to the MsDesign pulldown menu -> AutoRoute pick on the  Label 
Alignment option 
 
Label alignment. Stations/Offsets/NewPoint/ExistingPoints/Report: STATIONS 
 
There are many options to label and create points along the alignment and on 
offsets, as well as reports. 
 
We are going to simply label points along the centerline in this example. 
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After picking Stations as the method you will have the following dialog box 
appear: 
 

 
Pick OK to continue 

 
 
Fill in the dialog as shown and pick OK to continue. 
 
Label alignment. 

s/Report:  <Enter> 

 
 
Here is what you will see on screen, 
 

Stations/Offsets/NewPoint/ExistingPoint
to continue 
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and a close 
 

up showing the labeling, 

 
 
You can see that the tangent, curve and spiral have had the stationing labeled, 
as well as the beginning of Curve and Spiral.  New points have been created 
along the centerline with the description set as the station.  Some text overlap is 
apparent and a simple move command can clean this up.   
 
Now we should save this alignment to a file to protect us and allow us to retrieve 
it without having to recreate it from scratch. 
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Under the MsDesign pulldown menu -> AutoRoute
File option. 
 
On the command prompt window you will see t
and what the file is called. 
 
Alignment saved in C:\Jobs2005\MAPLE.HRZ. 
 

Create Profile

 pick on the Write .HRZ 

he message that tells you where 

 
 
Now that we are finished labeling and saving the horizontal alignment – lets 
continue with the vertical profile. 
 
Go to the MsDesign pulldown menu -> AutoRoute and pick the Extract 
Existing Ground Profile option. 
 
You will be asked to pick from a list of surfaces – we want GROUND as our 
surface. 
 

 
 
Pick on the word GROUND and pick the OK button. 
 
Next you will be shown a dialog box that will control how the profile will be drawn. 

his dialog: 
 
Change the settings to match t
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The only value you need to change is the Grid Interval Horizontal from 100 to 10.  
Press the OK utton to continue.  b
Next you will be asked: 
 

 
 
Pick YES to continue 
 
Pick lower starting corner of grid:  <Pick Somewhere Appropriate – maybe 
Above the Alignment> 
 
You will be asked if you wish to create the design profile? 
 

 
 
Answer NO for now. 
 



 

Now lets set the Profile_G
Layer Manager (View menu, Layer Manager… 
Then pick on the layer, as shown, a
 

rid layer to gray (color 9) for easier visibility,   Go to the 
command). 

nd change the color to gray(9). 

 

ook like this: 
 

 
Pick OK to continue. 
 
Now the profile will l

 
 

Design New Profile 

 have had a chance to look over our existing profile, we now need to 

MsDesign pulldown menu -> AutoRoute and pick on the Design 
Vertical Alignment option. 
Draw new profile grid or use existing New/<Existing>: <Enter> 
 
Enter vertical alignment name:   <MAPLE>  

 
Now that we
create a design alignment. 
 
Go to the 
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* NOTE * 
 
When naming a Vertical alignment, be sure to use only a single word, with no 
spaces, as the name, such as: 
ROAD1, Orange_Side_Road, Maple_Street, Pine-Street, Maple 
 
At this point, the program will draw a rubber band line from the bottom left corner 
of the graph.  This helps you to find the starting end of the profile. Pick on the 
graph where you wish to start the new profile line. 
 
Pick first VPI location:  < pick near the left edge around the existing 
profile> 
 
Change the dialog box that comes up, so the station and elevation look like the 
following; 
 

 
 
Pick the OK button. 
Next pick somewhere around the middle of the profile and change the dialog box 
so the station and elevation match the following; 
 

 
 
Pick the OK button. 
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Lastly pick over near the top right and change the settings 
elevation match the fol

so the station and 
lowing. 

 

 
 
Pick the OK button. 
Press ENTER to continue. 
 
Next 
 

you will be asked: 

 
 
Pick 
 
Now you will be prompted, 

Add/Curve/Delete/Move: CURVE 

 
<Pick the Red Circle at the FIRST bend in the vertical 

alignment> you need to, to be able to pick the red circle cleanly – 
don’t miss it
 

 150 <Enter> 
 

 
 

  <ENTER> 
 

YES to continue. 

Select VPI:  
(zoom in if 

) 

Enter or pick curve length:

Select VPI: <ENTER>

Add/Curve/Delete/Move:
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Next you will be asked if you wish to pass our cross section template along the 
design alignment and create a new surface.   
 

 

the template first. 

Section Template, let’s label the vertical curve. 
wn menu -> AutoRoute and pick on the 

Query/Label VPI option. 
 
Select existing VPI: <Pick the Red Circle at the FIRST bend in the 
vertical alignment> (zoom in if you need to, to be able to pick the red circle 

 miss it) 

llowing dialog box. 
 

 
Answer NO for now because we need to create 
 
Before we do the Cross 
Go to the MsDesign pulldo

cleanly – don’t
 
You will see the fo

 
 
Be sure to pick the Label Curve box to turn it on.  Then pick the OK button to 
continue. 
 
The curve will be label as shown below: 
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Select existing VPI:<enter> 
 
Note: if nothing appears, check the layering to make sure that the items are 
not in white on a white background. 
 

Create Cross Section Template

 

 
 

mplate let us save the Vertical Design file; 
 
Go to the wn menu -> AutoRoute and pick on the Write .VRT 

play the following to confirm it was saved. 
C:\Jobs2005\PGRID-0.VRT saved. 

 
Now lets create a template for our road cross section. 
Go to the MsDesign pulldown menu -> AutoRoute and pick on the Create 
Cross Section Template option. 

You will see a template editor on screen.  This editor has many options 
that need to be filled out. 

 

Before we create the te

MsDesign pulldo
File option. 
 
The command prompt will dis



 

 
 
Set each leg to the values shown. 
 

 
 

 
 

 
 
delete leg 4, 
 
Set the cut slope = 3.0 and fill slope = 2.0. 
Repeat legs 1 to 4 for the left side.  Once completed your template should look 
like the following. 
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Pick the SAVE and EXIT button. 
 
This will a w you to save the template for future use. 
Give the template the name of MAPLE, as shown. 
 
 

llo

 
 
Pick the SAVE button to continue. 
 
The following message is placed in the command prompt window. 
Cross section template file saved as C:\Jobs2005\MAPLE.TMP. 

170  Getting Started in MicroSurvey CAD 2005 



 

Create New Road Surface 
 
Now that the cross section template is complete,
design alignment.  Go to the MsDesi
on the Create New Design Surface
 
You will then see the following dialo
 

 we can now apply it to the 
gn pulldown menu -> AutoRoute and pick 
 option. 

g box: 

 
 

 
The following dialog comes up next,

Pick on our MAPLE template then pick the OPEN button to continue. 

 
 

 
 
You need to confirm the surface and alignment names match the box shown 
above.  Press the OK button. 
 
After a short period of time (a few seconds or so), the following prompt appears 
in the command window. 
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Draw or Show new TIN? Draw/Show/Nosho
 
 <Pick SHOW to see the TIN> 

w: 

ou if you want to create cross section data for 
later export to LandXML file, say NO to this. 
 
Your drawing should now look like this: 
 

 
You will then see a dialog asking y

 
 
After seeing the TIN you can hit the redraw button to clear the TIN.  The Surface 
does stay in
 

he road with the template applied, showing 
the outer ed h the original surface. 
 

 memory for future use. 

What you will now see on screen is t
ge where the template intersects wit



 

 
 

 

Output Cross Sections 
 
Now lets get some cross sections along the alignment. 
Go to the MsDesign pulldown menu -> AutoRoute and pick on the 
Cross Sections from Alignment option. 
 
Be sure to set the next dialog box exactly as show
correct results.  Special attention to ensure you select BOTH
 

Extract 

n below to ensure you get the 
 surfaces as shown. 

 
 
Pick the OK button to continue. 
 
This will draw lines on the plan view of the alignment to show where the cross 
sections will be extracted from. 
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Then: 
 

 
 
Answer 
 

NO. 

 
 
When you answer YES you will be shown another dialog box that controls the 
output of the sections.  Please fill it out exactly as shown: 
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 button to continue. 

ft corner:  <this is the starting location for the sections to be 
to the right of the drawing so they do not overlap on screen) 

 
 within the sheet. 

 
Pick the OK
 
Pick lower le
drawn> (go 

You will see the sheet size outlined and the sections draw
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Changed the color of Layer GRID to gray (9) as we did above for the profile.  
Here is a close up of a few of the sections: 
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Be sure to save the drawing and the surfaces, 
tutorial. 
 
(End of tutorial) 
 

 
 

as we covered in a previous 
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House Placement Tutorial 

Because of the size and complexity of this tutorial we have broken it down into 9 
smaller steps to make it easier for you to follow. 
 
Step 1) Open the Job 
 
Step 2) Working with the Toolbox 
 
Step 3) Entering a Lot 
 
Step 4) Defining the Lot Sides 
 
Step 5) Entering a House 
 
Step 6) Defining a House 
 
Step 7) Placing a House on the Lot 
 
Step 8) Computing Stakes 
 
Step 9) Staking Reports 
 

Open the Job

 

 
 
To begin, start a new drawing by running the New … command, found under the 
File drop-down menu. 
 
Pick the New button on the Project Manager, and name the job LOT.  
 
Pick Save to continue. 
 
Next you will see the following dialog box. 
Set the defaults as shown here 
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 button.  This brings 
 dialog boxes. 

Set the Toggles as shown here. 

 
At the bottom of the above dialog box, pick on the Toggles
up the following
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Now pick the OK button
and save the settings in
 
If the MicroSurve
remove it from the screen. 

 

Working with the Toolbox

 to return to the previous dialog and pick OK again to exit 
 that dialog box. 

y Assistant comes up on screen – pick the EXIT button to 

 

n menu -> Subdivision Palette… option. 
 
Go to the MsTools  pulldow
 

 
 

dragged to any location on screen (by picking in the top 
g the mouse button down, drag it to the 
access but not cover the drawing. 

The toolbox and can be 
bar in the Toolbox and while holdin
desired location) to make it easy to 
 

 

Entering a Lot 

Pick on this button:  
 
You will now be asked if 
 

you are entering a lot or block. 

 
 
In this example we will pick on the top button to enter a Lot. 
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Now you will be asked which of the 3 different ways you 
information. 

wish to enter the lot 

 

 
 

Pick on the first button:  
 
Now fill out t  with the lot number. 
 

he next dialog as show,

 

 
 
Pick on the  button to continue. OK



 

 
You will then be given some reminders on how to enter your lot. 
 

 
 
Pick on the OK
 
Now you owing dialog: 
 
 

 button to continue. 

will see the foll
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There will be

 

 many things to enter 
on this dialog.  To start with you 
need to tell the routine if you are 
entering a line or curve – then 
press enter to continue.  Then you 
will be asked to fill in each piece of 
information on that line or curve.  
Press enter after each piece of info 
has been entered. 

Here is what the first series of entries should look like: 
 

 

 

After entering this info – press 
enter and you will be given the 
previous dialog again, ready for 
new numbers.  You will also see 
the lot taking shape in the drawing 
after each side is entered. 

 
Here are the remain pieces of information for you to enter:  Fill in everything, one 
step at a time as you go, and press enter after each item: 
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After you en e last dialog – pick the FINISH button to 
continue. 
 
You will be ing: 
 

ter in all of the info on th

presented with the follow

 
 
Pick the 
 

YES button to continue. 
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Defining the Lot Sides  

you have the following lot drawn. 
 
At this point 
 

 
 
The following dialog is on screen: 
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 of the 4 buttons labeled Front, Left, Rear and Right, 
one at a time and then pick the linework related to the button. 
 
To start, pick the FRONT button and then pick the first line we drew.  Then 
press enter to continue. 
 
Then pick the LEFT button and pick the second line we drew. Then press enter 
to continue. 
 
Then pick the REAR button and pick the first curve and the next line we drew. 
Then press enter to continue. 
 
Finally pick the RIGHT button and pick the second curve and last line we drew. 
Then press enter to continue. 
 

The lot sides should have changed color to match the buttons on the 
dialog, as shown below: 

 

You need to pick on each



 

 
 
Pick the FINISH button to continue. 
 
Next a window will appear showing you the lot report. 

 
 
You may print it by going to the File pulldown menu in this window and picking 
the Print command. 
 
You may close the window by picking the X in the top right corner of the window. 
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Now you ve been on screen already) 
 

will be asked (and it may ha

 

NO to finish the lot entry. 
 

 
Pick on 

Entering a House 

Pick on this button:  
 
This will bring up the Building Library dialog. 

 

 will display any structures already saved in the library and if you pick 

 
 
This dialog
on one the preview will show up as well. 
Pick on the NEW button to add one. 
 
You will be given 2 different ways of entering house data. 
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We will pick on the first button to continue. 
 

 
 
Next give the house a name of Tutorial
 

 and pick the OK button to continue. 

 
 
At this point a new job is opened to allow you to create the house.  You will need 
to confirm the setup just like you do for other new drawings.  
  



 

 
 
Match the entries in the above dialog and pick the OK button to continue. 
 

 

Similar to the lot entry, the following dialog is displayed as a reminder of how to 
enter the information. 
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Pick the OK button to co
 
Pick each of the entries 
drawn in, and then press enter after 

ntinue. 

shown to define the units and direction the line is to be 
each value is entered. 
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FINISH button to continue. 

 the following dialog: 

 
Pick the 
 
You will see



 

 

 
 

Defining a House

 
Pick YES to continue. 

 

you have the following h
 
At this point ouse drawn. 
 

 

 dialog is on screen: 
 
The following
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, Rear and Right, 
 

 
 we drew.  Then 

press 

Then pick the LEFT button and pick the second line we drew. Then press enter 
to continue. 
 
Then pick the REAR button and pick the next  3 lines we drew. Then press 
enter to continue. 
 
Finally pick the RIGHT button and pick the last line we drew. Then press enter 
to continue. 
 
Pick the FINISH button to continue. 
 
Your house has now been saved in the house library and you are returned to the 
Building Library dialog.  Pick on your house name and you will see the preview, 
as shown below: 
 

You need to pick on each of the 4 buttons labeled Front, Left
one at a time and then pick the linework related to the button.

To start, pick the FRONT button and then pick the first line
enter to continue. 
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Placing a House on the Lot

Pick the Exit Building Library button to continue. 
 

 

 

 picking this button 
 
Now we need to place the House on the Lot.  We do this by
from the toolbox. 
 

 
 
It will bring up the following dialog box.  Fill it out as shown. 
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Once you pick the 
the house we designed 
attached to 
for placement. 

Insert Building button, 
will now be 

your crosshair and is ready 

 house around you can see the side ties update 
nd scaling the house 

the instructions on the dialog.  You may move the dialog out of the 
way by picking the top bar and dragging it to the side. 
 

 
NOTE: As you move the
dynamically.  You can switch between rotating, translating a
by following 

 

es update as the 
ed in any direction, giving 

you the closest tie to the property line, in 
each direction 
 
 
 
 
 
 
 
 
 
 
 
 

Here are a couple of examples as we move the house around and rotate it to get 
what we desire. 
 
 

You will see the house ti
house is mov
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Now we need to pick the desired location with the mouse, to place the house 

 
roughly on the lot. 

 

Once the house has bee
on the lot, you will have the ability to
tune the exact location by
“Tuner" dialog. 
 
You have course and fine
outer and inner directiona
can also specify the amount of 
movement for the two settings.  You
also rotate the house by the rotation 
arrows and even set the rotation based 
upon the angle between the house a
the lot. 

 
 

 

n placed roughly 
 fine-

 using this 

 control with the 
l buttons.  You 

 may 

nd 

. 
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You decide where you wish to place your house.  Mine is set as shown
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When you are happy with the final placement then pick the Place Building 
button to continue. 
 

 c aced on the house corners 
based upon the starting number and elevations set earlier. 

 

Computing Stake

Your house is now oordinated and points are pl

s 

he house on the lot, we need to
uction crew to layout the house

 
Now that you have t  add a few stakes to make it 
easier for the constr  in the field. 
 
We will add a few stakes around the footprint of the house, offset back from the 
actual footprint.  To do this we will go to the MsPoints drop-down menu -> 
Compute Points and pick the Compute Stakes… option.  Set the starting 
po
 
 

int number and offsets as shown below: 

 

 
Pick the OK button to continue. 

 
 
The following dialog box will now appear to let you choose the method of placing 
stakes. 
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Pick this button to place stakes at the building corners, offset from each line. 
 

 
 
Now you 
 
 

will see the following dialog box: 

 

Confirm the starting point number and 
offsets and elevation of the points you 
are about to place.   

 



 

Then pick th
you get points as shown 
will give you instructio
 

e house sides where you wish to place points. Pick the sides so that 
below:  (The white window at the top of the dialog box 

ns to walk you through placing points) 

 

Pick the STOP button to end placing new points and return to the previous 
other points if you desire, by using some of the other routines. 

 command. 
 

Staking Reports

 

dialog.  Set 
 
Pick the OK button to end the

 
 
Now that we have some stakes set, we need to generate a staking report for the 
field crew. 
 
Go to the MsPoints drop-down menu -> and pick on the Create Stakeout 

 the following dialog box: 

Report… option. 
 

You will see
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the point range for the stakes.  In my 
500..505  

 
Then pick the + sign to the right. 

 
The points on screen should now have little yellow X’s on them, like this: 
 

In the small white rectangle, enter in 

example I typed 



 

 

Coordinate Point Report button. 
m the report file location and name: 

 
Now pick on the 
Then confir
 

 

ntinue. 

created and displayed in our editor.  You may print this 
File pulldown menu  Print. 

 
Pick the OK button to co
 
The coordinate report is 
report by going to the 
 

 

You may close the window by picking the X in the top corner of the window. 
 
Now pick on the Angle/Distance Report button. 
Then confirm the report file location and name: 
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Pick the OK button to continue. 
 
 

 

Enter in the setup and backsight point 
numbers as show, and pick on the 
sorting method (we will do Angle first 

Number), then pick on the Add 
umber 

rom the setup to each stake.  They are 
temporary and will be removed with a redraw or zoom command. 
 

then 
Shots button. (now do the N
option and pick Add Shots again) 

 
The drawing will have yellow lines f

 
 
Now pick the View Report button to see the two reports we generated. 

206  Getting Started in MicroSurvey CAD 2005 



 

 

Angles the second by Point Numbers. 

 by going to the File pulldown menu (in this window) 
 option. 

You may close the window by picking the X in the top corner of the window. 
 
Pick the OK button to co tinue. 
 

SAVE 

 
The first was sorted by 
 
You may print this report
and pick the Print
 

n

Save your job by going to the File pulldown menu and picking on the 
option. 
 
(End of tutorial) 
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